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About This Book

WARNING! Text set off in this manner indicates that failure to follow directions could result in bodily
harm or loss of life.

CAUTION: Text set off in this manner indicates that failure to follow directions could result in damage
to equipment or loss of information.

NOTE: Text set off in this manner provides important supplemental information.
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1 Product Features

Standard Features

The HP RP7 Retail System features include:

● Designed for long-term deployment within general retail, hospitality, and other retail markets

● Choice of associate facing touchscreen:

◦ 15” Resistive

◦ 15” Projective Capacitive

◦ 17” Projective Capacitive

● Cable management features

● Water and dust resistant touch screens

● Flexible use with display tilt and height adjustments
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● Three optional peripherals that can be integrated:

◦ HP Retail Integrated Dual-Head MSR

◦ HP Retail Integrated Fingerprint Reader

◦ HP Retail Integrated Webcam

● Customer-facing two-line VFD (Vacuum Florescent Display); standard on select models (VFD can be
mounted to the RP7 or mounted on a separate stand)

● Customer-facing 10.4” LCD Display; optional (can be used with the two-line VFD if optional VFD
stand or CFD stand is used electrically; if used mechanically, only one can be used)

● Processor choices

● DDR3 memory

● Operating system choices

● Integrated NIC

● WiFi (some models)

● USB+PWR and cash drawer ports

● Hard drive and SSD choices

● RAID level 0,1 capable (RAID 1 can be HP factory preconfigured)

● Manageability tools

● Energy Star 5 qualified, EU Compliant, RoHS2 Compliant

● 87% energy efficient internal power supply adapter

● HP Limited Warranty, 3/3/3 standard: 3 years parts, 3 years labor, and 3 years on-site services
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Optional HP RP7 Accessories
The following HP RP7 accessories are available from HP.

1 HP RP7 Adjustable Stand 4 HP Retail Integrated Webcam

2 HP Retail RP7 VFD Customer Display 5 HP Retail Integrated Fingerprint Reader

3 HP Retail RP7 10.4” Customer Display 6 HP Retail Integrated Dual-Head MSR

NOTE: A stand-alone VFD that is mounted on a separate stand is also available from HP (not pictured
above).
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Front Panel Controls

Control Function

1 Menu Opens the On-Screen Display (OSD) main menu.

2 – (Minus) If the OSD menu is on, tap to navigate backward through the OSD menu
and decrease adjustment levels.

3 + (Plus) If the OSD menu is on, tap to navigate forward through the OSD menu and
increase adjustment levels.

4 OK If the OSD menu is on, tap to select a menu item.

5 Power LED Green = Fully powered.

Flashing Green = Sleep mode

Red = PC error condition (refer to Interpreting POST Diagnostic Front Panel
LEDs and Audible Codes on page 139 for more information).

Off = Power is off

6  Power Button Powers the system on and off, and sets the system to hibernate or sleep
mode.
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Using the On-Screen Display Menu
Use the On-Screen Display (OSD) to adjust the screen image based on your viewing preferences. To
access the OSD, do the following:

1. If the system is not already on, press the Power button to turn on the unit.

2. To activate the OSD function, tap in the front bezel area just to the left of the power icon.

3. To access the OSD Menu, tap the Menu icon on the monitor’s front panel.

4. To navigate through the OSD Menu, tap the + (Plus) icon on the monitor’s front panel to scroll up,
or the – (Minus) icon to scroll in reverse.

5. To select an item from the OSD Menu, use the + or – icons to scroll to and highlight your selection,
then tap the OK icon to select that function.

6. Adjust the item using the + or – icons on the front panel to adjust the scale.

7. After adjusting the function, select Save and Return, or Cancel if you don’t want to save the
setting, then select Exit from the Main Menu.

8. To lock or unlock the OSD, press and hold the Menu button for 10 seconds.

The following table lists the OSD Main menu items with a brief descriptions of each item.

Table 1-1  OSD Main Menu

Icon Main Menu Description

Brightness Adjusts the brightness level of the screen.

Contrast Adjusts the contrast level of the screen.

Color Selects and adjusts the screen color.

OSD Control Adjusts the on-screen display (OSD) controls.

Management Turns mode display and DDC/CI support on or off, and adjusts volume on models with
integrated speakers.

Language Selects the language in which the OSD menu is displayed. The factory default is English.

Information Selects and displays important information about the display.

Factory Reset Returns all OSD menu settings and DDC/CI controls to the factory default settings, except
the Language.

Exit Exits the OSD menu screen.
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Rear I/O Panel Components

1 Hard Drive Activity Light 9 Secured USB Port (includes a cover)

2 Line-Out Connector for powered audio devices
(green)

10 Line-In Audio Connector (blue)

3 DVI Connector (for a secondary display or the
optional HP Retail RP7 10.4” Customer
Display)

11 Parallel Port

4 PS/2 Mouse/Keyboard Connector (supports
only one PS/2 device at a time)

12 RJ-45 Network Connector

5 DC Out Power Connector (for the optional HP
Retail RP7 10.4” Customer Display only)

13 Powered Serial Ports 5V/12V

6 USB Ports (6) 14 Powered USB 12V

7 DC In Power Connector 15 Cash Drawer Connector (covered)

8 Powered USB 24V   

NOTE: The serial ports can be configured as 5V or 12V powered serial ports. Refer to Configuring
Powered Serial Ports on page 130 for more information.

NOTE: The 24-volt Powered USB connector and the 12-volt Powered USB connector are keyed
differently as a precaution to prevent connection errors.

NOTE: You must peel off the metallic tape over the cash drawer connector to connect a cash drawer.

CAUTION: The cash drawer connector is similar in size and shape to a modem jack. To avoid
damage to the computer, DO NOT plug a network cable into the cash drawer connector.

CAUTION: Do not connect any device other than the HP Retail RP7 10.4” Customer Display to the
DC Out Power Connector.
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2 Installing and Customizing the
Software

Installing and customizing the software
If your computer was not shipped with a Microsoft operating system, some portions of this
documentation do not apply. Additional information is available in online help after you install the
operating system.

CAUTION: Do not add optional hardware or third-party devices to the computer until the operating
system is successfully installed. Doing so may cause errors and prevent the operating system from
installing properly.

Installing the Windows Operating system

The first time you turn on the computer, the operating system is installed automatically. This process
takes about 5 to 10 minutes, depending on which operating system is being installed. Carefully read
and follow the instructions on the screen to complete the installation.

CAUTION: Once the automatic installation has begun, DO NOT TURN OFF THE COMPUTER UNTIL
THE PROCESS IS COMPLETE. Turning off the computer during the installation process may damage the
software that runs the computer or prevent its proper installation.

NOTE: If the computer shipped with more than one operating system language on the hard drive, the
installation process could take up to 60 minutes.
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Downloading Microsoft Windows updates

1. To set up your Internet connection, click Start > Internet Explorer and follow the instructions
on the screen.

2. In Windows 7, POSReady 7, Windows XP, and POSReady 9, click Start > All Programs >
Windows Update.

In Windows 7 and POSReady 7, the Windows Update screen appears. Click view
available updates and make sure all critical updates are selected. Click the Install button and
follow the instructions on the screen.

In Windows XP and POSReady 2009, you will be directed to the Microsoft Windows Update
Web site. If you see one or more pop-up windows that ask you to install a program from
http://www.microsoft.com, click Yes to install the program. Follow the instructions on the
Microsoft Web site to scan for updates and install critical updates and service packs.

In Windows 8.x and Industry 8.1, point to the upper-right or lower-right corner of the Start screen
to display the charms. Select Settings > Change PC Settings > Windows Update and
follow the instructions on the screen.

It is recommended that you install all of the critical updates and service packs.

3. After the updates have been installed, Windows will prompt you to reboot the machine. Be sure to
save any files or documents that you may have open before rebooting. Then select Yes to reboot
the machine.

4. Run Windows Update monthly thereafter.

Installing or upgrading device drivers (Windows systems)

When installing optional hardware devices after the operating system installation is complete, you must
also install the drivers for each of the devices.

If prompted for the i386 directory, replace the path specification with C:\i386, or use the Browse
button in the dialog box to locate the i386 folder. This action points the operating system to the
appropriate drivers.

Obtain the latest support software, including support software for the operating system from
http://www.hp.com/support. Select your country and language, select Drivers & Downloads,
enter the model number of the computer, and click the Go button.

Customizing the monitor display (Windows systems)

If you wish, you can select or change the monitor model, refresh rates, screen resolution, color settings,
font sizes, and power management settings.

To change display settings in Windows XP, right-click on the Windows Desktop and select Properties.

To change display settings in Windows 7 and POSReady 7, right-click on the Windows Desktop and
select Personalize.
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In Windows 8.x and Industry 8.1, you can customize display settings for the Start screen and Desktop.
To customize the Start screen, point to the upper-right or lower-right corner of the Start screen to display
the charms. Select Settings > Change PC Settings > Personalize and change the display
settings. To customize the Desktop, right-click on the Desktop, and then select Personalize to change
the display settings.

For more information, refer to the online documentation provided with the graphics controller utility or
the documentation that came with your monitor.

Accessing disk image (ISO) files

There may be disk image files (ISO files) included on your PC that contain the installation software for
additional software. These CD image files are located in the folder C:\SWSetup\ISOs. Each .iso file
can be burned to CD media to create an installation CD. It is recommended that these disks be created
and the software installed in order to get the most from your PC. If present, the software and image file
names are:

● Vision Diagnostics – software to perform diagnostic activities on your PC

Turning off the computer
To properly turn off the computer, first shut down the operating system software.

▲ Click Start  > Shut down.

Finding more information
NOTE: Some or all of the following documents are available on the computer hard drive.

● Getting Started—Helps you connect the computer and peripheral devices and set up factory-
provided software; also includes basic troubleshooting information should you encounter any
problems during initial startup.

● Hardware Reference Guide—Provides an overview of the product hardware, as well as
instructions for upgrading this series of computers; includes information on RTC batteries, memory,
and power supply.

● Maintenance and Service Guide (English only)—Provides information on parts removal and
replacement, troubleshooting, Desktop Management, setup utilities, safety, routine care, connector
pin assignments, POST error messages, diagnostic indicator lights and error codes.

● Regulatory, Safety and Environmental Notices—Provides safety and regulatory information that
ensures compliance with U.S., Canadian, and various international regulations.

Turning off the computer 9



3 Computer Setup (F10) Utility

Computer Setup (F10) Utilities
Use Computer Setup (F10) Utility to do the following:

● Change factory default settings.

● Set the system date and time.

● Set, view, change, or verify the system configuration, including settings for processor, graphics,
memory, audio, storage, communications, and input devices.

● Modify the boot order of bootable devices such as hard drives, diskette drives, optical drives, or
USB flash media devices.

● Enable Quick Boot, which is faster than Full Boot but does not run all of the diagnostic tests run
during a Full Boot. You can set the system to:

❑ always Quick Boot (default);

❑ periodically Full Boot (from every 1 to 30 days); or

❑ always Full Boot.

● Select Post Messages Enabled or Disabled to change the display status of Power-On Self-Test
(POST) messages. Post Messages Disabled suppresses most POST messages, such as memory
count, product name, and other non-error text messages. If a POST error occurs, the error is
displayed regardless of the mode selected. To manually switch to Post Messages Enabled during
POST, press any key (except F1 through F12).

● Establish an Ownership Tag, the text of which is displayed each time the system is turned on or
restarted.

● Enter the Asset Tag or property identification number assigned by the company to this computer.

● Enable the power-on password prompt during system restarts (warm boots) as well as during
power-on.

● Establish a setup password that controls access to the Computer Setup (F10) Utility and the settings
described in this section.

● Secure integrated I/O functionality, including the serial, USB, or parallel ports, audio, or
embedded NIC, so that they cannot be used until they are unsecured.
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● Enable or disable removable media boot ability.

● Enable or disable legacy diskette write ability (when supported by hardware).

● Solve system configuration errors detected but not automatically fixed during the Power-On Self-
Test (POST).

● Replicate the system setup by saving system configuration information on diskette and restoring it
on one or more computers.

● Execute self-tests on a specified ATA hard drive (when supported by drive).

● Enable or disable DriveLock security (when supported by drive).

Using Computer Setup (F10) Utilities

Computer Setup can be accessed only by turning the computer on or restarting the system. To access
the Computer Setup Utilities menu, complete the following steps:

1. Turn on or restart the computer. If you are in Microsoft Windows, click Start > Shut Down >
Restart.

2. Press Esc while the “Press the ESC key for Startup Menu” message is displayed at the bottom of
the screen.

NOTE: If you do not press Esc at the appropriate time, you must restart the computer and again
press Esc when the monitor light turns green to access the utility.

3. Press F10 to enter Computer Setup.

4. A choice of five headings appears in the Computer Setup Utilities menu: File, Storage, Security,
Power, and Advanced.

5. Use the arrow (left and right) keys to select the appropriate heading. Use the arrow (up and down)
keys to select the option you want, then press Enter. To return to the Computer Setup Utilities
menu, press Esc.

6. To apply and save changes, select File > Save Changes and Exit.

● If you have made changes that you do not want applied, select Ignore Changes and
Exit.

● To reset to factory settings or previously saved default settings (some models), select Apply
Defaults and Exit. This option will restore the original factory system defaults.

CAUTION: Do NOT turn the computer power OFF while the BIOS is saving the Computer Setup
(F10) changes because the CMOS could become corrupted. It is safe to turn off the computer only after
exiting the F10 Setup screen.

Table 3-1  Computer Setup (F10) Utility

Heading Table

File Computer Setup—File on page 12

Storage Computer Setup—Storage on page 13
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Table 3-1  Computer Setup (F10) Utility (continued)

Security Computer Setup—Security on page 15

Power Computer Setup—Power on page 19

Advanced Computer Setup—Advanced on page 20

Computer Setup—File

NOTE: Support for specific Computer Setup options may vary depending on the hardware
configuration.

Table 3-2  Computer Setup—File

Option Description

System Information Lists:

● Product name

● SKU number (some models)

● Processor type/speed/stepping

● Cache size (L1/L2/L3) (dual core processors have this listed twice)

● Installed memory size/speed, number of channels (single or dual) (if applicable)

● Integrated MAC address for embedded, enabled NIC (if applicable)

● System BIOS (includes family name and version)

● Chassis serial number

● Asset tracking number

● ME firmware version

● ME Management mode

About Displays copyright notice.

Set Time and Date Allows you to set system time and date.

Flash System ROM Allows you to update the system ROM with a BIOS image file located on removable media.

Replicated Setup Save to Removable Media

Saves system configuration, including CMOS, to a formatted 1.44-MB diskette, a USB flash media
device, or a diskette-like device (a storage device set to emulate a diskette drive).

Restore from Removable Media

Restores system configuration from a diskette, a USB flash media device, or a diskette-like device.
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Table 3-2  Computer Setup—File (continued)

Default Setup Save Current Settings as Default

Saves the current system configuration settings as the default.

Restore Factory Settings as Default

Restores the factory system configuration settings as the default.

Apply Defaults and
Exit

Applies the currently selected default settings and clears any established passwords.

Ignore Changes
and Exit

Exits Computer Setup without applying or saving any changes.

Save Changes and
Exit

Saves changes to system configuration or default settings and exits Computer Setup.

Computer Setup—Storage

NOTE: Support for specific Computer Setup options may vary depending on the hardware
configuration.

Table 3-3  Computer Setup—Storage

Option Description

Device
Configuration

Lists all installed BIOS-controlled storage devices.

When a device is selected, detailed information and options are displayed. The following options
may be presented:

Hard Disk: Size, model, firmware version, serial number, connector color, SMART, translation
mode.

● Translation Mode (ATA disks only)

Lets you select the translation mode to be used for the device. This enables the BIOS to access
disks partitioned and formatted on other systems and may be necessary for users of older
versions of UNIX (e.g., SCO UNIX version 3.2). Options are Automatic, Bit-Shift, LBA Assisted,
User, and Off.

Available only when the drive translation mode is set to User, allows you to specify the
parameters (logical cylinders, heads, and sectors per track) used by the BIOS to translate disk
I/O requests (from the operating system or an application) into terms the hard drive can
accept. Logical cylinders may not exceed 1024. The number of heads may not exceed 256.
The number of sectors per track may not exceed 63.

CAUTION: Ordinarily, the translation mode selected automatically by the BIOS should not
be changed. If the selected translation mode is not compatible with the translation mode that
was active when the disk was partitioned and formatted, the data on the disk will be
inaccessible.

Default Values

SATA Defaults

See Translation Mode above for details.
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Table 3-3  Computer Setup—Storage (continued)

Storage Options SATA Emulation

WARNING! SATA emulation changes may prevent access to existing hard drive data and
degrade or corrupt established volumes.

Allows you to choose how the SATA controller and devices are accessed by the operating system.
There are three supported options: IDE, RAID, and AHCI (default).

IDE - This is the most backwards-compatible setting of the three options. Operating systems usually
do not require additional driver support in IDE mode.

RAID - Allows DOS and boot access to RAID volumes. Use this mode with the RAID device driver
loaded in the operating system to take advantage of RAID features.

AHCI (default option) - Allows operating systems with AHCI device drivers loaded to take
advantage of more advanced features of the SATA controller.

NOTE: The RAID/AHCI device driver must be installed prior to attempting to boot from a RAID/
AHCI volume. If you attempt to boot from a RAID/AHCI volume without the required device driver
installed, the system will crash (blue screen). RAID volumes may become corrupted if they are
booted to after disabling RAID.

Removable Media Boot

Enables/disables ability to boot the system from removable media. Default is enabled.

DPS Self-Test Allows you to execute self-tests on ATA hard drives capable of performing the Drive Protection
System (DPS) self-tests.

NOTE: This selection will only appear when at least one drive capable of performing the DPS self-
tests is attached to the system.

Boot Order Allows you to:

● Specify the order in which EFI boot sources (such as a USB flash media device, USB hard
drive, USB optical drive, or internal optical drive) are checked for a bootable operating system
image. Each device on the list may be individually excluded from or included for consideration
as a bootable operating system source.

● Specify the order in which legacy boot sources (such as a network interface card, internal
hard drive, USB optical drive, or internal optical drive) are checked for a bootable operating
system image. Each device on the list may be individually excluded from or included for
consideration as a bootable operating system source.

● Specify the order of attached hard drives. The first hard drive in the order will have priority in
the boot sequence and will be recognized as drive C (if any devices are attached).

NOTE: MS-DOS drive lettering assignments may not apply after a non-MS-DOS operating system
has started.

Shortcut to Temporarily Override Boot Order

To boot one time from a device other than the default device specified in Boot Order, restart the
computer and press F9 when the monitor light turns green. After POST is completed, a list of
bootable devices is displayed. Use the arrow keys to select the preferred bootable device and press
Enter. The computer then boots from the selected non-default device for this one time.
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Computer Setup—Security

NOTE: Support for specific Computer Setup options may vary depending on the hardware
configuration.

Table 3-4  Computer Setup—Security

Option Description

Setup Password Allows you to set and enable a setup (administrator) password.

NOTE: If the setup password is set, it is required to change Computer Setup options, flash the
ROM, and make changes to certain plug and play settings under Windows.

NOTE: This selection will only appear when at least one drive that supports the DriveLock feature
is attached to the system.

See the Desktop Management Guide for more information.

Power-On
Password

Allows you to set and enable a power-on password. The power-on password prompt appears after
a power cycle. If the user does not enter the correct power-on password, the unit will not boot.

NOTE: This selection will only appear when at least one drive that supports the DriveLock feature
is attached to the system.

See the Desktop Management Guide for more information.

Password Options

(This selection appears
only if a power-on
password or setup
password is set.)

Allows you to enable/disable:

● Lock Legacy Resources (appears if a setup password is set). Default is enabled.

● Setup Browse Mode (appears if a setup password is set) (allows viewing, but not changing,
the F10 Setup Options without entering setup password). Default is enabled.

● Password prompt on F9, F11, & F12 (allows access to menus without entering setup
password). Default is enabled.

● Network Server Mode (appears if a power-on password is set). Default is disabled.

See the Desktop Management Guide for more information.

Smart Cover (some
models)

Allows you to:

● Lock/unlock the Cover Lock.

● Set the Cover Removal Sensor to Disable/Notify User/Setup Password.

NOTE: Notify User alerts the user that the sensor has detected that the cover has been removed.

Default is disabled.
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Table 3-4  Computer Setup—Security (continued)

Device Security Allows you to set Device Available/Device Hidden (default is Device Available) for:

● Embedded security device (some models)

● System audio

● Serial ports (some models)

● Parallel port (some models)

● Network controllers (some models)

● SATA0

● SATA1

● SATA2 (some models)

● SATA4 (some models)

USB Security Allows you to set Enabled/Disabled (default is Enabled) for:

● Front USB Ports

◦ Monitor/USB Hub Ports

● Rear USB Ports

◦ RJ45/USB Port 1

◦ RJ45/USB Port 2

◦ 4 Stack/USB Port 1

◦ 4 Stack/USB Port 2

◦ 4 Stack/USB Port 3

◦ 4 Stack/USB Port 4

● Accessory USB Ports

◦ Red/24V Power USB Port

◦ Green/12V Power USB Port

Slot Security Allows you to disable any the PCI Express x1 slot. Default is enabled.

Network Boot Enables/disables the computer’s ability to boot from an operating system installed on a network
server. (Feature available on NIC models only; the network controller must be either a PCI
expansion card or embedded on the system board.) Default is enabled.
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Table 3-4  Computer Setup—Security (continued)

System IDs Allows you to set:

● Asset tag (18-byte identifier), a property identification number assigned by the company to the
computer.

● Ownership tag (80-byte identifier) displayed during POST.

● Universal Unique Identifier (UUID) number. The UUID can only be updated if the current
chassis serial number is invalid. (These ID numbers are normally set in the factory and are used
to uniquely identify the system.)

● Keyboard locale setting for System ID entry.

Master Boot Record
Security

Enables/disables Master Boot Record Security. Default is disabled.

The Master Boot Record (MBR) contains information needed to successfully boot from a disk and to
access the data stored on the disk. Master Boot Record Security may prevent unintentional or
malicious changes to the MBR, such as those caused by some viruses or by the incorrect use of
certain disk utilities. It also allows you to recover the "last known good" MBR, should changes to the
MBR be detected when the system is restarted.

When MBR Security is enabled, the BIOS prevents any changes being made to the MBR of the
current bootable disk while in MS-DOS or Windows Safe Mode.

NOTE: Most operating systems control access to the MBR of the current bootable disk; the BIOS
cannot prevent changes that may occur while the operating system is running.

Each time the workstation is turned on or restarted, the BIOS compares the MBR of the current
bootable disk to the previously saved MBR. If changes are detected and if the current bootable disk
is the same disk from which the MBR was previously saved, a POST error message is displayed.
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Table 3-4  Computer Setup—Security (continued)

System Security
(some models: these
options are hardware
dependent)

Data Execution Prevention (some models) (enable/disable) - Helps prevent operating system security
breaches. Default is enabled.

Virtualization Technology (VTx)(some models) (enable/disable) - Controls the virtualization features
of the processor. Changing this setting requires turning the computer off and then back on. Default
is disabled.

Virtualization Technology Directed I/O (VTd) (some models) (enable/disable) - Controls
virtualization DMA remapping features of the chipset. Changing this setting requires turning the
computer off and then back on. Default is disabled.

Intel TXT (LT) Support (some models) (enable/disable) - Controls the underlying processor and
chipset features needed to support a virtual appliance. Changing this setting requires turning the
computer off and then back on. Default is disabled. To enable this feature you must enable the
following features:

● Embedded Security Device Support

● Virtualization Technology

● Virtualization Technology Directed I/O

Embedded Security Device Support (some models) (enable/disable) - Permits activation and
deactivation of the Embedded Security Device. Changing this setting requires turning the computer
off and then back on.

NOTE: To configure the Embedded Security Device, a Setup password must be set.

● Reset to Factory Settings (some models) (Do not reset/Reset) - Resetting to factory defaults will
erase all security keys. Changing this setting requires turning the computer off and then back
on. Default is Do not reset.

CAUTION: The embedded security device is a critical component of many security schemes.
Erasing the security keys will prevent access to data protected by the Embedded Security
Device. Choosing Reset to Factory Settings may result in significant data loss.

OS management of Embedded Security Device (some models) (enable/disable) - This option allows
the user to limit operating system control of the Embedded Security Device. Changing this setting
requires turning the computer off and then back on. This option allows the user to limit OS control of
the Embedded Security Device. Default is enabled.

Reset of Embedded Security Device through OS (some models) (enable/disable) - This option allows
the user to limit the operating system ability to request a Reset to Factory Settings of the Embedded
Security Device. Changing this setting requires turning the computer off and then back on. Default is
disabled.

NOTE: To enable this option, a Setup password must be set.

DriveLock Security Allows you to assign or modify a master or user password for hard drives. When this feature is
enabled, the user is prompted to provide one of the DriveLock passwords during POST. If neither is
successfully entered, the hard drive will remain inaccessible until one of the passwords is
successfully provided during a subsequent cold-boot sequence.

NOTE: This selection will only appear when at least one drive that supports the DriveLock feature
is attached to the system.
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Computer Setup—Power

NOTE: Support for specific Computer Setup options may vary depending on the hardware
configuration.

Table 3-5  Computer Setup—Power

Option Description

OS Power
Management

● Runtime Power Management— Enable/Disable. Allows certain operating systems to reduce
processor voltage and frequency when the current software load does not require the full
capabilities of the processor. Default is enabled.

● Idle Power Savings—Extended/Normal. Allows certain operating systems to decrease the
processors power consumption when the processor is idle. Default is extended.

● Unique Sleep State Blink Rates—Enable/Disable. This feature is designed to provide a visual
indication of what sleep state the system is in. Each sleep state has a unique blink pattern.
Default is disabled.

◦ S0 (On) = Solid green LED.

◦ S3 (Stand By)= 3 blinks at 1Hz (50% duty cycle) followed by a pause of 2 seconds
(green LED) — repeated cycles of 3 blinks and a pause.

◦ S4 (Hibernation)= 4 blinks at 1Hz (50% duty cycle) followed by a pause of 2 seconds
(green LED) — repeated cycles of 4 blinks and a pause.

◦ S5 (Soft Off) = LED is off.

NOTE: If this feature is disabled, S4 and S5 both have the LED off. S1 (no longer supported)
and S3 use 1 blink per second.

Hardware Power
Management

SATA Power Management – Enables or disables SATA bus and/or device power management.
Default is enabled.

S5 Maximum Power Savings—Turns off power to all nonessential hardware when system is off to
meet EUP Lot 6 requirement of less than 1 Watt power usage. Default is disabled.

Thermal Fan idle mode—This bar graph controls the minimum permitted fan speed.

NOTE: This setting only changes the minimum fan speed. The fans are still automatically
controlled.
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Computer Setup—Advanced

NOTE: Support for specific Computer Setup options may vary depending on the hardware
configuration.

Table 3-6  Computer Setup—Advanced (for advanced users)

Option Heading

Power-On Options Allows you to set:

● POST mode (QuickBoot, Clear Memory, FullBoot, or FullBoot Every x Days).

◦ QuickBoot (default) = Do not clear memory or perform a memory test.

◦ FullBoot = Memory test (count) on cold boot. Clears memory on all boots.

◦ Clear Memory = No memory count on cold boot. Clears memory on all boots.

◦ FullBoot Every x Days = Memory count on 1st cold boot on or after the xth day. No more
memory counts until 1st cold boot on or after x days. Clears memory on all boots.

● POST messages (enable/disable). Default is disabled.

● Press the ESC key for Startup Menu (Enable/Disable). Default is enabled.

● Option ROM Prompt (enable/disable). Enabling this feature will cause the system to display a
message before loading option ROMs. (This feature is supported on some models only.)
Default is enabled.

● After Power Loss (off/on/previous state). Default is Power off. Setting this option to:

◦ Power off—causes the computer to remain powered off when power is restored.

◦ Power on—causes the computer to power on automatically as soon as power is restored.

◦ Previous state—causes the computer to power on automatically as soon as power is
restored, if it was on when power was lost.

NOTE: If you turn off power to the computer using the switch on a power strip, you will not be
able to use the suspend/sleep feature or the Remote Management features.

● POST Delay (in seconds). Enabling this feature will add a user-specified delay to the POST
process. This delay is sometimes needed for hard disks on some PCI cards that spin up very
slowly, so slowly that they are not ready to boot by the time POST is finished. The POST delay
also gives you more time to select F10 to enter Computer (F10) Setup. Default is None.

● Remote Wakeup Boot Source (remote server/local hard drive). Default is Local hard drive.

● System Recovery Boot Support (Enable/Disable). Setting this feature to enabled will display the
text F11 = Recovery during POST. Disabling the feature prevents the text from being
displayed. However, pressing F11 will still attempt to boot to the HP Backup and Recovery
partition. See Factory Recovery Boot Support for more information. Default is disabled.

● Bypass F1 Prompt on Configuration Changes (Enable/Disable). Allows you to set the computer
not to confirm when changes were made. Default is disabled.

BIOS Power-On Allows you to set the computer to turn on automatically at a time you specify.

Onboard Devices ● Allows you to set resources for or disable Legacy devices.

● Allows to you change voltage settings for powered serial ports.
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Table 3-6  Computer Setup—Advanced (for advanced users) (continued)

Resources you can change include:

◦ Parallel Port

◦ Serial Port A

◦ Serial Port B

◦ Serial Port A Voltage

◦ Serial Port B Voltage

● Available settings for powered ports are:

◦ 0V (default)

◦ +5V

◦ +12V

Bus Options On some models, allows you to enable or disable:

● PCI SERR# Generation. Default is enabled.

● PCI VGA Palette Snooping, which sets the VGA palette snooping bit in PCI configuration
space; only needed when more than one graphics controller is installed. Default is disabled.
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Table 3-6  Computer Setup—Advanced (for advanced users) (continued)

Device Options Allows you to set:

● Turbo Mode (enable/disable). Allows you to enable and disable the Intel Turbo Mode feature,
which allows one core of the system to run at a higher than standard frequency and power if
other cores are idle. Default is enabled.

● Printer mode (Bi-Directional, EPP + ECP, Output Only). Default is EPP+ECP.

● Num Lock State at Power-On (off/on). Default is off.

● Integrated Video (enable/disable). Use this option to disable the integrated video controller
when another video controller is present in the system. Default is enabled.

● Internal Speaker (some models) (does not affect external speakers). Default is enabled.

● NIC Option ROM Download (PXE, iSCSI, disabled). The BIOS contains an embedded NIC
option ROM to allow the unit to boot through the network to a PXE server. This is typically used
to download a corporate image to a hard drive. The NIC option ROM takes up memory space
below 1MB commonly referred to as DOS Compatibility Hole (DCH) space. This space is
limited. This F10 option will allow users to disable the downloading of this embedded NIC
option ROM thus giving more DCH space for additional PCI cards which may need option
ROM space. The default will be to have the NIC option-ROM-enabled. Default is PXE.

● Multi-Processor (enable/disable). Use this option to disable multi-processor support under the
OS. Default is enabled.

● System Health Timer Timeout (Disabled, 1 min, 5 min, 15 min). Allows you to set a timer to
reset the system in case of a lock up. An expired timer indicates the system hung. Default is
disabled.

● Cash Drawer Port. Use this option to enable/disable the cash drawer port that comes on the
system board.

● Hard Drive Activity LED. Use this option to enable/disable the hard drive LED. When this
feature is disabled, there is no visual indication for hard drive activity.

NOTE: To hide a device, see Security > Device Security.

VGA Configuration Displayed only if there are multiple PCI video adapters in the system. Allows you to specify which
VGA controller will be the “boot” or primary VGA controller.

AMT Configuration Allows you to set:

● AMT (enable/disable). Allows you to enable or disable functions of the embedded
Management Engine (ME) such as Active Management Technology (AMT). If set to disable, the
Management Engine is set to a temporarily disabled state and will not provide functions
beyond necessary system configuration. Default is enabled.

● Unconfigure AMT/ME (enable/disable). Allows you to unconfigure any provisioned
management settings for AMT. The AMT settings are restored to factory defaults. This feature
should be used with caution as AMT will not be able to provide any set AMT management
functions once unconfigured. Default is disabled.

● Watchdog Timer (enable/disable). Allows you to set amount of time for a operating system
and BIOS watchdog alert to be sent if the timers are not deactivated. BIOS watchdog is
deactivated by BIOS and would indicate that a halt occurred during execution if the alert is
sent to the management console. An operating system alert is deactivated by the operating
system image and would indicate that a hang occurred during its initialization. Default is
enabled.
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Recovering the Configuration Settings
This method of recovery requires that you first perform the Save to Removable Media command
with the Computer Setup (F10) Utility before Restore is needed.

NOTE: It is recommended that you save any modified computer configuration settings to a diskette, a
USB flash media device, or a diskette-like device (a storage device set to emulate a diskette drive) and
save the diskette or device for possible future use.

To restore the configuration, insert the diskette, USB flash media device, or other storage media
emulating a diskette with the saved configuration and perform the Restore from Removable
Media command with the Computer Setup (F10) Utility.
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4 Using HP PC Hardware Diagnostics

The HP diagnostic strategy has changed over time. Vision Diagnostics was used on Retail units in a
Windows environment until October of 2012. Since November 2012, HP is utilizing HP PC Hardware
Diagnostics, which are diagnostics used outside the Windows environment.

Vision Diagnostics (select models only)
NOTE: Vision Diagnostics is included on CD with some computer models only.

The Vision Diagnostics utility allows you to view information about the hardware configuration of the
computer and perform hardware diagnostic tests on the subsystems of the computer. The utility
simplifies the process of effectively identifying, diagnosing, and isolating hardware issues.

The Survey tab is displayed when you invoke Vision Diagnostics. This tab shows the current
configuration of the computer. From the Survey tab, there is access to several categories of information
about the computer. Other tabs provide additional information, including diagnostic test options and
test results. The information in each screen of the utility can be saved as an html file and stored on a
diskette or USB flash drive.

Use Vision Diagnostics to determine if all the devices installed on the computer are recognized by the
system and functioning properly. Running tests is optional but recommended after installing or
connecting a new device.

You should run tests, save the test results, and print them so that you have printed reports available
before placing a call to the Customer Support Center.

NOTE: Third party devices may not be detected by Vision Diagnostics.

Accessing Vision Diagnostics (select models only)

To access Vision Diagnostics, you must copy the utility onto a USB flash drive then boot to the USB flash
drive.
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NOTE: Vision Diagnostics is included with some computer models only.

If you have already downloaded Vision Diagnostics to a USB flash drive, then begin the following
procedure at step 2.

1. Select Start > All Programs > HP Help and Support > HP Vision Diagnostics USB
Creation and follow the wizard prompts to install Vision Diagnostics on the USB flash drive.

2. While the computer is on, insert the USB flash drive into the a USB port on the computer.

3. Shut down the operating system and turn off the computer.

4. Turn on the computer. The system will boot into Vision Diagnostics.

NOTE: If the system does not boot to the USB flash drive, you may need to change the boot
order in the Computer Setup utility. Refer to the Maintenance and Service Guide (English only) for
more information.

5. At the boot menu, select either the Vision Diagnostics utility to test the various hardware
components in the computer or the HP Memory Test utility to test memory only.

NOTE: The HP Memory Test is a comprehensive memory diagnostic utility that is run as a stand-
alone application, outside of Vision Diagnostics.

6. If running Vision Diagnostics, select the appropriate language and click Continue.

7. In the End User License Agreement page, select Agree if you agree with the terms. The Vision
Diagnostics utility launches with the Survey tab displayed.

Using HP Diagnostic Solutions
The UEFI-based hardware diagnostic solution is included with some HP products. You can use this tool
even if the computer will not boot to the operating system.

Why run HP PC Hardware Diagnostics

The HP PC Hardware Diagnostic tools simplify the process of diagnosing hardware issues and expedite
the support process when issues are found. The tools save time by pinpointing the component that
needs to be replaced.

● Isolate true hardware failures: The diagnostics run outside of the operating system so they
effectively isolate hardware failures from issues that may be caused by the operating system or
other software components.

● Failure ID: When a failure is detected that requires hardware replacement, a 24-digit Failure ID
is generated. This ID can then be provided to the call agent, who will either schedule support or
provide replacement parts.
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How to access and run HP PC Hardware Diagnostics

You can run the diagnostics from one of three places, depending on your preference and the health of
the computer.

1. Turn on the computer and press Esc repeatedly until the BIOS Boot Menu appears.

2. Press F2 or select Diagnostics (F2).

Pressing F2 signals the system to search for the diagnostics in the following locations:

a. A connected USB drive (to download the diagnostics tools to a USB drive, see the instructions
in Downloading HP PC Hardware Diagnostics to a USB device on page 26)

b. The hard disk drive

c. A core set of diagnostics in the BIOS (for memory and hard disk drive) that are accessible
only if the USB or hard disk drive versions are not detected

Downloading HP PC Hardware Diagnostics to a USB device

1. Go to http://www.hp.com.

2. Click the Drivers & Downloads link.

3. Enter the product name in the text box and click the Go button.

4. Select your specific computer model.

5. Select your operating system.

6. In the Diagnostic section, click the HP UEFI Support Environment link. This link provides
additional information.

- or -

Click the Download button and select Run. The download includes instructions (in English) on
how to install the tools on the USB device.

NOTE: HP diagnostic solutions are developed to test components typically included on HP products.
They may not diagnose all third-party accessories that can be added to the system.
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5 Illustrated parts catalog

Plastics

Item Description Spare part number

(1) Display head back panel 702769-001

(2) Rear I/O cover 709678-001

(3) Power supply cover 702787-001

(4) Top panel, small (for top rear of display) 702770-001

(5) VESA mounting bracket cover 716045-001

 In Mold Decoration (IMD; customizable) covers:  

(6) Panel with hole (for bottom rear on models with VFD) 702781-001

(7) Panel without hole (for bottom rear on models without VFD) 702786-001
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Item Description Spare part number

 Power adapter 180-W  

 Does not include power cord 702778-001

 Includes 6 foot power cord 736170-001

System Board, Memory, and Processors

Description Spare part number

System board (includes replacement thermal material)  

For use in models without Windows 8 operating systems 674783-001

For use in models with Windows 8.1 Professional 674783-601

For use in models with Windows Embedded 8.1 Industry 674783-701

Memory modules (PC3-12800, 1666-MHz)  

8-GB 689374-001

4-GB 689373-001

2-GB 689372-001

Processors (include replacement thermal material)  

Intel Core i5 2400S processor, 2.5 GHz, 65W 640953-001

Intel Core i3 2120 processor, 3.3 GHz, 65W 638629-001

Intel Pentium Dual-Core G850 processor, 2.9 GHz, 65W 655973-001

Intel Celeron G540 processor, 2.5 GHz 665119-001

Drives

Description Spare part number

500-GB, 7200-rpm hard drive 686217-001

320-GB, 7200-rpm hard drive 639135-001

256 GB Solid State Drive (SSD) 661842-001

128 GB Solid State Drive (SSD) 665961-001

64 GB Solid State Drive (SSD) 711906-001

32 GB MLC Flash, 2.5-in 686616-001
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Misc parts

Item Description Spare part number

(1) Blower 702774-001

(2) USB+PWR 24V and Cash Drawer port daughter card 702775-001

(3) WLAN module, 802.11a/b/g/n  

 HP WLAN 802.11 a/b/g/n 2x2 PCIe module 695915-001

 Intel 640x 802.11 a/b/g/n PCIe module 717382-001

(4) Heat sink (includes replacement thermal material) 702773-001

(5) EMI shield (metal plate), display head 702780-001

(6) USB security cover for secured USB port on I/O panel 702779-001

(7) Grommet, hard drive 594220-001

 Speaker 730571-001

 HP Value Stand 739188-001

 Rubber foot and screw kit 702788-001
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Cables

Description Spare part number

Cables  

(1) LED cable assembly 702777-001

(2) Hard drive harness cable assembly 702776-001

(3) Hood sensor 702772-001

(4) Antenna kit 702771-001
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Accessories
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Description Spare part number

Accessories  

(1) Base 702786-001

(2) VFD customer display, pole 702783-001

(3) Retail integrated webcam for live video functions 695661-001

(4) Retail integrated fingerprint reader to add security identification functions 739189-001

(5) Retail integrated dual-head magnetic stripe reader for card data read 690685-001

(6) VFD customer display, bracket 702784-001

(7) Display, customer-facing (CFD), 10.4 inch 667837-001

* Display, associate-facing (AFD), 15 inch capacitive 667839-001

* Display, associate-facing (AFD), 15 inch resistive 667838-001

(8) Display, associate-facing (AFD), 17 inch capacitive 667841-001

(9) Bracket for HP Retail RP7 10.4” Customer Display 703269-001

(10) Cable kit for HP Retail RP7 10.4” Customer Display, includes:

● USB A cable

● DC-in cable

● DVI-D cable

● Audio cable

702782-001

(11) VFD customer display, cable kit (includes USB power cable and VFD cable) 702785-001

* HP Retail Integrated Barcode Scanner 733520-001
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VFD Display Kit

Description Spare part number

VFD Display Kit 695662-001

(1) VFD customer display

(2) Display bracket

(3) Poles (2)

(4) IMD panel

(5) Screws

(6) Cable kit
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Stand-alone VFD Display Kit

Description Spare part number

Stand-alone VFD Display Kit 695662-001

(1) VFD customer display

(2) Poles (3)

(3) Stand

(4) Cable kit
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Sequential part number listing

Spare part
number

Description

594220-001 Grommet, hard drive

638629-001 Intel Core i3 2120 processor, 3.3 GHz, 65W

639135-001 320-GB, 7200-rpm hard drive

640953-001 Intel Core i5 2400S processor, 2.5 GHz, 65W

655973-001 Intel Pentium Dual-Core G850 processor, 2.9 GHz, 65W

661842-001 256 GB Solid State Drive (SSD)

665119-001 Intel Celeron G540 processor, 2.5 GHz

665961-001 128 GB Solid State Drive (SSD)

667837-001 Display, customer-facing (CFD), 10.4 inch

667838-001 Display, associate-facing (AFD), 15 inch resistive

667839-001 Display, associate-facing (AFD), 15 inch capacitive

667841-001 Display, associate-facing (AFD), 17 inch capacitive

674783-001 System board for use in models without Windows 8 operating systems (includes replacement thermal
material)

674783-601 System board for use in models with Windows 8.1 Professional (includes thermal material)

674783-701 System board for use in models with Windows Embedded 8.1 Industry (includes thermal material)

686217-001 500-GB, 7200-rpm hard drive

686616-001 32 GB MLC Flash, 2.5-in

689372-001 2-GB memory module (PC3-12800, 1666-MHz, DODIMM)

689373-001 4-GB memory module (PC3-12800, 1666-MHz, DODIMM)

689374-001 8-GB memory module (PC3-12800, 1666-MHz, DODIMM)

690685-001 Retail integrated dual-head magnetic stripe reader for card data read

695661-001 Retail integrated webcam for live video functions

695662-001 VFD Kit

695665-001 Stand-alone VFD Kit

695915-001 HP WLAN 802.11 a/b/g/n 2x2 PCIe module

702769-001 Display head back panel

702770-001 IMD top panel, small (for top rear of display)

702771-001 Antenna kit

702772-001 Hood sensor
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Spare part
number

Description

702773-001 Heat sink (includes replacement thermal material)

702774-001 Blower

702775-001 USB+PWR 24V and Cash Drawer port daughter card

702776-001 Hard drive harness cable assembly

702777-001 LED cable assembly

702778-001 Power adapter, 180-W; does not include power cord

702788-001 Rubber foot and screw kit

702779-001 USB security cover for secured USB port on I/O panel

702780-001 EMI shield (metal plate), display head

702781-001 VFD customer display

702782-001 Cable kit for HP Retail RP7 10.4” Customer Display

702783-001 VFD customer display, pole

702784-001 VFD customer display, bracket

702785-001 VFD customer display, cable kit (includes USB power cable and VFD cable)

702787-001 Power supply cover

703269-001 Bracket for HP Retail RP7 10.4” Customer Display

709678-001 Rear I/O cover

716045-001 VESA mounting bracket cover

717382-001 Intel 640x 802.11 a/b/g/n PCIe module

711906-001 64 GB Solid State Drive (SSD)

730571-001 Speaker

733520-001 HP Retail Integrated Barcode Scanner

736170-001 Power adapter, 180-W; includes 6 foot power cord

739188-001 HP Value Stand

739189-001 Retail integrated fingerprint reader to add security identification functions
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6 Serial and Parallel ATA Drive
Guidelines and Features

NOTE: Serial ATA = SATA

Parallel ATA = PATA

HP only supports the use of SATA hard drives on these models of computer. No PATA drives are
supported on any of these models.

SATA Hard Drives

Serial ATA Hard Drive Characteristics  

Number of pins/conductors in data cable 7/7

Number of pins in power cable 15

Maximum data cable length 39.37 in (100 cm)

Data interface voltage differential 400-700 mV

Drive voltages 3.3 V, 5 V, 12 V

Jumpers for configuring drive N/A

Data transfer rate 3.0 Gb/s

SATA connectors on the system board are color coded to make identification easier.

SATA Identification Color Port Attachment Sequence

Primary channel, device 0 Dark blue SATA 0 1

Primary channel, device 1 Light Blue SATA 2 4

NOTE: If there is an error on the application of the attach rules, a POST error message may be
displayed.
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SATA Hard Drive Cables

SATA Data Cable

Always use an HP approved SATA 3.0 Gb/s cable as it is fully backwards compatible with the SATA
1.5 Gb/s drives.

Current HP desktop products ship with SATA 3.0 Gb/s hard drives.

SATA data cables are susceptible to damage if overflexed. Never crease a SATA data cable and never
bend it tighter than a 30 mm (1.18 in) radius.

The SATA data cable is a thin, 7-pin cable designed to transmit data for only a single drive. As shown
in the table, each cable has 3 grounds, and 4 transmit/receive pins.

Pin Number Usage Device Plug Host Plug

P1 Ground Ground Ground

P2* A+ Transmit data Receive data

P3* A- Transmit data Receive data

P4 Ground Ground Ground

P5** B- Receive data Transmit data

P6** B+ Receive data Transmit data

P7 Ground Ground Ground

*P2 and P3 differential signal pair

**P5 and P6 differential signal pair

SATA Power Cable

Pin Usage Notes Pin Usage Notes

P1 V3.3 3.3 V power P9 V5 5 V power

P2 V3.3 3.3 V power P10 Ground

P3 V3.3 3.3 V power P11 Ground

P4 Ground P12 Ground

P5 Ground P13 V12 12 V power

P6 Ground P14 V12 12 V power

P7 V5 5 V power P15 V12 12 V power

P8 V5 5 V power
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ATA SMART Drives
The Self Monitoring Analysis and Recording Technology (SMART) ATA drives for the HP Personal
Computers have built-in drive failure prediction that warns the user or network administrator of an
impending failure or crash of the hard drive. The SMART drive tracks fault prediction and failure
indication parameters such as reallocated sector count, spin retry count, and calibration retry count. If
the drive determines that a failure is imminent, it generates a fault alert.

Hard Drive Capacities
The combination of the file system and the operating system used in the computer determines the
maximum usable size of a drive partition. A drive partition is the largest segment of a drive that may be
properly accessed by the operating system. A single hard drive may therefore be subdivided into a
number of unique drive partitions in order to make use of all of its space.

Because of the differences in the way that drive sizes are calculated, the size reported by the operating
system may differ from that marked on the hard drive or listed in the computer specification. Drive size
calculations by drive manufacturers are bytes to the base 10 while calculations by Microsoft are bytes
to the base 2.

Drive/Partition Capacity Limits

 Maximum Size

File System Controller Type Operating System Partition Drive

FAT 32 ATA Windows 7 32 GB 2 TB

NTFS ATA Windows 7 2 TB 2 TB
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7 Routine Care, and Disassembly
Preparation

This chapter provides general service information for the computer. Adherence to the procedures and
precautions described in this chapter is essential for proper service.

CAUTION: When the computer is plugged into an AC power source, voltage is always applied to
the system board. You must disconnect the power cord from the power source before opening the
computer to prevent system board or component damage.

Electrostatic Discharge Information
A sudden discharge of static electricity from your finger or other conductor can destroy static-sensitive
devices or microcircuitry. Often the spark is neither felt nor heard, but damage occurs. An electronic
device exposed to electrostatic discharge (ESD) may not appear to be affected at all and can work
perfectly throughout a normal cycle. The device may function normally for a while, but it has been
degraded in the internal layers, reducing its life expectancy.

Networks built into many integrated circuits provide some protection, but in many cases, the discharge
contains enough power to alter device parameters or melt silicon junctions.

Generating Static

The following table shows that:

● Different activities generate different amounts of static electricity.

● Static electricity increases as humidity decreases.

 Relative Humidity

Event 55% 40% 10%

Walking across carpet

Walking across vinyl floor

Motions of bench worker

Removing DIPs* from plastic tube

7,500 V

3,000 V

400 V

400 V

15,000 V

5,000 V

800 V

700 V

35,000 V

12,000 V

6,000 V

2,000 V
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Removing DIPs* from vinyl tray

Removing DIPs* from Styrofoam

Removing bubble pack from PCB

Packing PCBs in foam-lined box

2,000 V

3,500 V

7,000 V

5,000 V

4,000 V

5,000 V

20,000 V

11,000 V

11,500 V

14,500 V

26,500 V

21,000 V

*These are then multi-packaged inside plastic tubes, trays, or Styrofoam.

NOTE: 700 volts can degrade a product.

Preventing Electrostatic Damage to Equipment

Many electronic components are sensitive to ESD. Circuitry design and structure determine the degree
of sensitivity. The following packaging and grounding precautions are necessary to prevent damage to
electric components and accessories.

● To avoid hand contact, transport products in static-safe containers such as tubes, bags, or boxes.

● Protect all electrostatic parts and assemblies with conductive or approved containers or
packaging.

● Keep electrostatic sensitive parts in their containers until they arrive at static-free stations.

● Place items on a grounded surface before removing them from their container.

● Always be properly grounded when touching a sensitive component or assembly.

● Avoid contact with pins, leads, or circuitry.

● Place reusable electrostatic-sensitive parts from assemblies in protective packaging or conductive
foam.

Personal Grounding Methods and Equipment

Use the following equipment to prevent static electricity damage to equipment:

● Wrist straps are flexible straps with a maximum of one-megohm ± 10% resistance in the ground
cords. To provide proper ground, a strap must be worn snug against bare skin. The ground cord
must be connected and fit snugly into the banana plug connector on the grounding mat or
workstation.

● Heel straps/Toe straps/Boot straps can be used at standing workstations and are
compatible with most types of shoes or boots. On conductive floors or dissipative floor mats, use
them on both feet with a maximum of one-megohm ± 10% resistance between the operator and
ground.

Static Shielding Protection Levels
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Method Voltage

Antistatic plastic

Carbon-loaded plastic

Metallized laminate

1,500

7,500

15,000

Grounding the Work Area

To prevent static damage at the work area, use the following precautions:

● Cover the work surface with approved static-dissipative material. Provide a wrist strap connected
to the work surface and properly grounded tools and equipment.

● Use static-dissipative mats, foot straps, or air ionizers to give added protection.

● Handle electrostatic sensitive components, parts, and assemblies by the case or PCB laminate.
Handle them only at static-free work areas.

● Turn off power and input signals before inserting and removing connectors or test equipment.

● Use fixtures made of static-safe materials when fixtures must directly contact dissipative surfaces.

● Keep work area free of nonconductive materials such as ordinary plastic assembly aids and
Styrofoam.

● Use field service tools, such as cutters, screwdrivers, and vacuums, that are conductive.

Recommended Materials and Equipment

Materials and equipment that are recommended for use in preventing static electricity include:

● Antistatic tape

● Antistatic smocks, aprons, or sleeve protectors

● Conductive bins and other assembly or soldering aids

● Conductive foam

● Conductive tabletop workstations with ground cord of one-megohm +/- 10% resistance

● Static-dissipative table or floor mats with hard tie to ground

● Field service kits

● Static awareness labels

● Wrist straps and footwear straps providing one-megohm +/- 10% resistance

● Material handling packages

● Conductive plastic bags

● Conductive plastic tubes
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● Conductive tote boxes

● Opaque shielding bags

● Transparent metallized shielding bags

● Transparent shielding tubes

Tools Needed
A Phillips, Torx, or flat blade screwdriver is needed for most of the procedures described in this guide.

Computer Operating Guidelines and Routine Care
Follow these guidelines to properly set up and care for the computer and monitor:

● Although the display is water resistant, it is best to keep it away from excessive moisture, direct
sunlight, and extremes of heat and cold.

● Never restrict the airflow into the computer by blocking any vents or air intakes.

● Never operate the computer with the cover or side panel removed.

● If the computer is to be operated within a separate enclosure, intake and exhaust ventilation must
be provided on the enclosure, and the same operating guidelines listed above will still apply.

● Keep liquids away from the computer vents.

● Never cover the ventilation slots on the monitor with any type of material.

● Install or enable power management functions of the operating system or other software, including
sleep states.

● Turn off the computer before you do either of the following:

◦ Wipe the exterior of the computer with a soft, damp cloth as needed. Using cleaning
products may discolor or damage the finish.

◦ Occasionally clean the air vents on all vented sides of the computer. Lint, dust, and other
foreign matter can block the vents and limit the airflow.

Touch Screen Maintenance
Keep your display and touch sensor clean. The touch sensor requires very little maintenance. HP
recommends that you periodically clean the glass touch sensor surface. Be sure to turn off your display
before cleaning. Typically, an isopropyl alcohol and water solution ratio of 50:50 is the best cleaning
agent for your touch sensor. It is important to avoid using any caustic chemicals on the touch sensor. Do
not use any vinegar-based solutions.

Apply the cleaner with a soft, lint-free cloth or a microfiber cloth. Avoid using gritty cloths. Always
dampen the cloth and then clean the sensor. Be sure to spray the cleaning liquid onto the cloth, not the
sensor, so that drips do not seep inside the display or stain the bezel.
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Service Considerations
Listed below are some of the considerations that you should keep in mind during the disassembly and
assembly of the computer.

Power Supply Fan

The power supply fan is a variable-speed fan based on the temperature in the power supply.

CAUTION: The cooling fan is always on when the computer is in the “On” mode. The cooling fan is
off when the computer is in “Standby,” “Suspend,” or “Off” modes.

You must disconnect the power cord from the power source before opening the computer to prevent
system board or component damage.

Tools and Software Requirements

To service the computer, you need the following:

● Torx T-15 screwdriver (HP screwdriver with bits, PN 161946-001)

● Torx T-15 screwdriver with small diameter shank (for certain front bezel removal)

● Flat-bladed screwdriver (may sometimes be used in place of the Torx screwdriver)

● Phillips #2 screwdriver

● Diagnostics software

● HP tamper-resistant T-15 wrench (Smart Cover FailSafe Key, PN 166527-001) or HP tamper-
resistant bits (Smart Cover FailSafe Key, PN 166527-002)

Screws

The screws used in the computer are not interchangeable. They may have standard or metric threads
and may be of different lengths. If an incorrect screw is used during the reassembly process, it can
damage the unit. HP strongly recommends that all screws removed during disassembly be kept with the
part that was removed, then returned to their proper locations.

CAUTION: Metric screws have a black finish. U.S. screws have a silver finish and are used on hard
drives only.

CAUTION: As each subassembly is removed from the computer, it should be placed away from the
work area to prevent damage.

Cables and Connectors

Most cables used throughout the unit are flat, flexible cables. These cables must be handled with care
to avoid damage. Apply only the tension required to seat or unseat the cables during insertion or
removal from the connector. Handle cables by the connector whenever possible. In all cases, avoid
bending or twisting the cables, and ensure that the cables are routed in such a way that they cannot be
caught or snagged by parts being removed or replaced.
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CAUTION: When servicing this computer, ensure that cables are placed in their proper location
during the reassembly process. Improper cable placement can damage the computer.

Hard Drives

Handle hard drives as delicate, precision components, avoiding all physical shock and vibration. This
applies to failed drives as well as replacement spares.

● If a drive must be mailed, place the drive in a bubble-pack mailer or other suitable protective
packaging and label the package “Fragile: Handle With Care.”

● Do not remove hard drives from the shipping package for storage. Keep hard drives in their
protective packaging until they are actually mounted in the CPU.

● Avoid dropping drives from any height onto any surface.

● If you are inserting or removing a hard drive, turn off the computer. Do not remove a hard drive
while the computer is on or in standby mode.

● Before handling a drive, ensure that you are discharged of static electricity. While handling a
drive, avoid touching the connector. For more information about preventing electrostatic damage,
refer to Electrostatic Discharge Information on page 40

● Do not use excessive force when inserting a drive.

● Avoid exposing a hard drive to liquids, temperature extremes, or products that have magnetic
fields such as monitors or speakers.

Lithium Coin Cell Battery

The battery that comes with the computer provides power to the real-time clock and has a minimum
lifetime of about three years.

See the appropriate removal and replacement chapter for the chassis you are working on in this guide
for instructions on the replacement procedures.

WARNING! This computer contains a lithium battery. There is a risk of fire and chemical burn if the
battery is handled improperly. Do not disassemble, crush, puncture, short external contacts, dispose in
water or fire, or expose it to temperatures higher than 140ºF (60ºC). Do not attempt to recharge the
battery.

NOTE: Batteries, battery packs, and accumulators should not be disposed of together with the
general household waste. In order to forward them to recycling or proper disposal, please use the
public collection system or return them to HP, their authorized partners, or their agents.
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8 Removal and Replacement
Procedures

Adherence to the procedures and precautions described in this chapter is essential for proper service.
After completing all necessary removal and replacement procedures, run the Diagnostics utility to verify
that all components operate properly.

NOTE: Not all features listed in this guide are available on all computers.

Preparation for Disassembly
See Routine Care, and Disassembly Preparation on page 40 for initial safety procedures.

1. Close any open software applications.

2. Exit the operating system.

3. Turn off the computer and any peripheral devices that are connected to it.

4. Disconnect the power cord from the electrical outlet and then from the computer.

CAUTION: Regardless of the power-on state, voltage is always present on the system board as
long as the system is plugged into an active AC outlet. You must disconnect the power cord to
avoid damage to the internal components of the computer.

5. Disconnect all peripheral device cables from the computer.

NOTE: During disassembly, label each cable as you remove it, noting its position and routing.
Keep all screws with the units removed.

CAUTION: The screws used in the computer are of different thread sizes and lengths; using the
wrong screw in an application may damage the unit.
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Power Supply Cover

Description Spare part number

Power supply cover 702787-001

1. Prepare the computer for disassembly (Preparation for Disassembly on page 46).

2. Pull the power supply cover back then lift if up and off the unit.

To install the power supply cover, reverse the removal procedure.
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Decorative Panel (IMD)

Description Spare part number

IMD panel with hole (for bottom rear on models with VFD) 702781-001

IMD panel without hole (for bottom rear on models without VFD) 702786-001

1. Prepare the computer for disassembly (Preparation for Disassembly on page 46).

2. Remove the power supply cover (Power Supply Cover on page 47).

3. Remove the decorative panel on the rear of the unit by gently prying the panel away from the
base at the tab locations on the top and sides of the panel as indicated below (1). Then pull the
top of the panel away from the base (2) and push straight down on the panel to release the
bottom tabs (3).

To replace decorative panel, reverse the removal procedure.
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Rear I/O Panel

Description Spare part number

Rear I/O panel 709678-001

1. Prepare the computer for disassembly (Preparation for Disassembly on page 46).

2. Slide down the two levers on the upper corners of the rear I/O panel (1) and rotate the cover off
(2).

To remove the rear I/O panel, reverse the installation procedures.
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Using the USB Security Cover

Description Spare part number

USB security cover 702779-001

1. Prepare the computer for disassembly (Preparation for Disassembly on page 46).

2. Remove the rear I/O panel (Rear I/O Panel on page 49).

3. Push inward on the tab at the bottom of the USB security cover (1) and rotate the bottom of the
cover up (2) to remove it.

4. Insert the USB device into the USB port.
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5. Insert the top of the USB security cover into the I/O panel at an angle with the bottom of the cover
slightly raised (1), then rotate the bottom down so that the cover snaps in place (2).

NOTE: If the USB device has a cable, place the cable in the channel on the side of the security
cover.

6. If you want to secure the USB port, remove the security screw from the inside of the rear I/O panel
and install the screw in the screw hole on the side of the USB security cover.

NOTE: You must use a T-10 tamper-resistant Torx screwdriver available from HP to install the
security screw.
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7. Replace the rear I/O cover by placing the hooks on the bottom of the cover into the slots on the
bottom of the chassis (1). Then rotate the top of the I/O cover up so that it snaps securely onto the
chassis (2).

8. Reconnect the power cord and press the power button.
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Mounting Bracket Cover

Description Spare part number

VESA mounting bracket cover 716045-001

1. Prepare the computer for disassembly (Preparation for Disassembly on page 46).

2. Slide the stand's mounting bracket cover up and off the mounting bracket.

To remove the mounting bracket cover, reverse the installation procedures.
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Display Head Back Panel

Description Spare part number

Display head back panel 702769-001

1. Prepare the computer for disassembly (Preparation for Disassembly on page 46).

2. Remove the rear I/O panel (Rear I/O Panel on page 49).

3. Press inward on the buttons located near the bottom sides of the display head's back panel (1)
then slide the back panel up and off the display head (2).

To remove the display head back panel, reverse the installation procedures.

54 Chapter 8   Removal and Replacement Procedures



RP7 Adjustable Stand
NOTE: This section provides instructions for installing the RP7 Adjustable Stand if the stand was
purchased separately.

1. Prepare the computer for disassembly (Preparation for Disassembly on page 46).

2. Remove the power supply cover (Power Supply Cover on page 47).

3. Remove the decorative panel (Decorative Panel (IMD) on page 48).

4. Remove the rear I/O panel (Rear I/O Panel on page 49).

5. Attach the RP7 display head to the stand's mounting bracket by aligning the slots on the display
head with the hooks on the mounting bracket and sliding the display down (1). Install the three
screws included with the stand through the mounting bracket and into the display head to secure it
in place (2).
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6. Slide the mounting bracket cover down over the stand's mounting bracket.

7. Rotate open the small door at the base of the power supply housing (1) and slide the power
supply brick into the housing (2).

NOTE: To keep the power adapter from getting jammed, make sure the rubber feet are pointed
toward the display.
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8. Close the small door at the base of the power supply housing (1). Route the power supply cord
through side of the base, then out through the center of the base (2) and up through the cable
retainer on the neck of the stand. Insert the cord into the cable retainer clip next to the power port
(3) and connect the cord to the DC In power port.

9. Route the AC power cord through the bottom of the stand's base, then through the cavity inside
the base and connect the cord to the power supply brick. Insert the cord into the cable retainer
clip on the side of the base and connect the other end of the cord to an electrical outlet.
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10. Snap the decorative panel back onto the rear of the base.

11. Replace the power supply cover by lowering it down over the neck of the base then sliding it back
until it snaps in place.
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12. Replace the rear I/O cover by placing the hooks on the bottom of the cover into the slots on the
bottom of the chassis (1). Then rotate the top of the I/O cover up so that it snaps securely onto the
chassis (2).

13. You can adjust the monitor stand height and tilt to a variety of positions.
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Routing Cables to External Devices
1. Turn off the computer properly through the operating system, then turn off any external devices.

2. Disconnect the power cord from the power outlet.

CAUTION: Regardless of the power-on state, voltage is always present on the system board as
long as the system is plugged into an active AC outlet. You must disconnect the power cord to
avoid damage to the internal components of the computer.

3. Remove the rear I/O panel (Rear I/O Panel on page 49).

4. Remove the power supply cover (Power Supply Cover on page 47).

5. Remove the decorative panel (Decorative Panel (IMD) on page 48).

6. Route the cables underneath the rear of the base, then through the hole in the center of the base,
then up through the cable retainer on the neck of the stand and into the appropriate I/O port.

CAUTION: Be sure that the power cord is secured by the retainer clip next to the DC In power
connector on the rear I/O so that the cord does not get pulled out of the connector.
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7. Snap the decorative panel back onto the rear of the base.

8. Replace the power supply cover by lowering it down over the neck of the base then sliding it back
until it snaps in place.
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9. Replace the rear I/O cover by placing the hooks on the bottom of the cover into the slots on the
bottom of the chassis (1). Then rotate the top of the I/O cover up so that it snaps securely onto the
chassis (2).

10. Reconnect the power cord and press the power button.
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Optional Integrated USB Modules
There are three optional integrated USB modules available from HP (sold separately).

1 retail integrated webcam for live video functions 695661-001

2 retail integrated fingerprint reader to add security identification functions 739189-001

3 retail integrated dual-head magnetic stripe reader for card data read 690685-001

 HP Retail Integrated Barcode Scanner 733520-001

The integrated USB modules can be installed on the top or bottom of the display head or on either side
of the display head.

NOTE: If you are installing a webcam, do not install it on the sides of the display head. The webcam
must be installed on top of the display head for proper video orientation.

NOTE: These USB ports only support the USB modules listed above. They do not support optical
drives or hard drives.
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The procedure for installing an integrated USB module is the same for all modules. To install a USB
module:

1. Prepare the computer for disassembly (Preparation for Disassembly on page 46).

2. Remove the rear I/O panel (Rear I/O Panel on page 49).

3. Remove the display head back panel (Display Head Back Panel on page 54).

4. Remove the two screws that attach the USB cover plate to the display head (1) then slide the cover
plate off the display head (2). Remove only the cover plate that is in the location where you want
to install the USB module.

NOTE: There is a small “fingernail” slot in the center of the interior edge of the USB cover plate
that can be used to help slide the cover plate off the unit.
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5. Pull the plug that is inserted in the USB port out of the port.

NOTE: Some models do not have plugs in the USB ports.

6. Slide the screw hole cover plate on the module back (1) and insert the USB connector on the
module into the USB port (2).
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7. Install the two screws that were previously removed (1) and slide the cover plate on the module
forward to cover the screws (2).

8. Slide the display head's back panel down onto the rear of the display head.
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9. Replace the rear I/O cover by placing the hooks on the bottom of the cover into the slots on the
bottom of the chassis (1). Then rotate the top of the I/O cover up so that it snaps securely onto the
chassis (2).

10. Reconnect the power cord and press the power button.
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Optional HP Retail RP7 10.4” Customer Display

Description Spare part number

VFD Kit 695662-001

Stand-alone VFD Kit 695665-001

Bracket for HP Retail RP7 10.4” Customer Display 703269-001

Cable kit for HP Retail RP7 10.4” Customer Display 702782-001

To remove the display:

1. Prepare the computer for disassembly (Preparation for Disassembly on page 46).

2. Remove the rear I/O panel (Rear I/O Panel on page 49).

3. Disconnect the USB, DC-out power, DVI, and audio cables from the rear I/O connectors on the
base unit noting their location for reinstallation.

4. Thread the cables through the cable retainer on the neck of the stand.

5. Remove the power supply cover:

a. Press the top and sides of the power supply cover and push back firmly to disengage the
hooks.

b. Lift and remove the power supply cover. For more information, see Power Supply Cover
on page 47.

68 Chapter 8   Removal and Replacement Procedures



6. Remove the display from the stand:

a. Remove the two Torx T15 screws (1) that secure the display hinge mounting bracket to the
stand.

CAUTION: Use one hand to support the display when removing the second screw to
prevent the display from falling.

b. Pull the display away from the stand and lay it face down on a soft, non-abrasive material
(2).

7. Release the decorative panel:

a. On the rear of the stand by gently prying it away at the tab locations on the top and sides of
the panel.

b. Pull the top of the panel away from the stand and push down to release the bottom tabs. For
more information, see Decorative Panel (IMD) on page 48.

8. Move the panel away from the stand to facilitate cable removal.
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9. Thread the cables out of the pass-through channel at the bottom of the stand and through the hole
in the decorative panel.

10. Remove the hinge/backplate from the display:

a. Remove the two Torx T15 screws (1) that secure the hinge/backplate to the display.

b. Slide the hinge/backplate toward the bottom of the display and lift it away from the display
(2).
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c. Thread the cables through the opening in the backplate and remove the hinge/backplate
(3).

11. Remove the cables from the I/O connectors on the back of the display noting their location for
reinstallation.

To replace the display:

1. Connect the cables to the I/O connectors on the back of the display. Insert the DVI cable into the
retainer clip at the base of the display head.

Optional HP Retail RP7 10.4” Customer Display 71



2. Route the audio, DVI, USB, and power cables through the hole in the customer display back plate
(1). Connect the back plate to the customer display by aligning the hooks on the back plate with
the slots on the back of the display and sliding the back plate up (2) so that the screw holes on the
back plate are aligned with the screw holes on the display. Install the two screws to secure the
back plate to the display (3).

3. Slide the cable ends through the hole in the center of the decorative panel that was included with
the customer display.
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4. Route the audio, DVI, USB, and power cables through the rear of the base and out the front of the
base, then up through the cable retainer on the neck of the RP7 stand and connect the cables to
the RP7 I/O ports.

5. Snap the decorative panel onto the rear of the base.
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6. Slide the back plate mounting bracket into the mounting hole on the rear of the RP7 base (1), and
install the two screws included with the customer display into the screw holes on top of the
mounting bracket (2).

7. Replace the power supply cover by lowering it down over the neck of the base then sliding it back
until it snaps in place.
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8. Replace the rear I/O cover by placing the hooks on the bottom of the cover into the slots on the
bottom of the chassis (1). Then rotate the top of the I/O cover up so that it snaps securely onto the
chassis (2).

9. Reconnect the power cord and press the power button on both displays.
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Optional HP Retail RP7 VFD Customer Display

Description Spare part number

VFD customer display, pole 702783-001

VFD customer display, bracket 702784-001

VFD customer display, cable kit (includes USB power cable and VFD cable) 702785-001

The integrated VFD customer display can be installed with no poles attached, or with one or two poles
attached, depending on the desired height of the VFD. There are two recommended procedures for
installing the VFD customer display: one procedure without poles attached and another procedure with
poles attached.

Installing the VFD Customer Display Without Poles

1. Prepare the computer for disassembly (Preparation for Disassembly on page 46).

2. Remove the rear I/O panel (Rear I/O Panel on page 49).

3. Remove the power supply cover (Power Supply Cover on page 47).

4. Remove the decorative panel (Decorative Panel (IMD) on page 48).

5. Route the VFD extension cable that was included with the VFD through the rear of the base and
out the front of the base (1), then though the cable retainer (2). Connect the extension cable to
the I/O cable included with the VFD (3) and connect the I/O cable to the 12V USB port on the
RP7.
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6. Wrap the excess extension cable around the hooks on the rear of the base.

7. Insert the end of the extension cable through the hole in the decorative panel (1) and snap the
decorative panel onto the rear of the base (2).
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8. Insert the VFD cable through the center of the mounting bracket (1) and slide the VFD onto the
mounting bracket (2).

9. Lay the VFD face down on clean, dry cloth and connect the VFD cable to the extension cable.
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10. Slide the VFD mounting bracket into the mounting hole on the rear of the RP7 base (1), and install
the two screws included with the VFD into the screw holes on top of the mounting bracket (2).

11. Replace the power supply cover by lowering it down over the neck of the base then sliding it back
until it snaps in place.
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12. Replace the rear I/O cover by placing the hooks on the bottom of the cover into the slots on the
bottom of the chassis (1). Then rotate the top of the I/O cover up so that it snaps securely onto the
chassis (2).

13. Reconnect the power cord and press the power button.

VFD Customer Display With One or Two Poles

1. Prepare the computer for disassembly (Preparation for Disassembly on page 46).

2. Remove the rear I/O panel (Rear I/O Panel on page 49).

3. Remove the power supply cover (Power Supply Cover on page 47).

4. Remove the decorative panel (Decorative Panel (IMD) on page 48).
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5. Slide either one or two poles onto the mounting bracket, depending on the desired height of the
VFD. Thread the extension cable through the top of the pole assembly and out the bottom of the
mounting bracket (1). Connect the extension cable to the VFD cable (2), then slide the VFD onto
the pole assembly (3).

6. Route the VFD extension cable through the hole in the decorative panel that was included with the
VFD, then through the rear of the base (1) and out the front of the base. Continue to route the
extension cable up through the cable retainer (2) and connect the extension cable to the I/O
cable included with the VFD (3). Connect the I/O cable to the 12V USB port on the RP7.
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7. Wrap the excess extension cable around the hooks on the rear of the base.

8. Snap the decorative plate onto the rear of the base.
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9. Slide the VFD mounting bracket into the mounting hole on the rear of the RP7 base (1), and install
the two screws included with the VFD into the screw holes on top of the mounting bracket (2).

10. Replace the power supply cover by lowering it down over the neck of the base then sliding it back
until it snaps in place.
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11. Replace the rear I/O cover by placing the hooks on the bottom of the cover into the slots on the
bottom of the chassis (1). Then rotate the top of the I/O cover up so that it snaps securely onto the
chassis (2).

12. Reconnect the power cord and press the power button.
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Cable Management
Proper routing of the internal cables is critical to the operation of the computer. Follow good cable
management practices when working inside the computer.

● Keep cables away from major heat sources like the heat sink.

● Do not jam cables on top of expansion cards or memory modules. Printed circuit cards like these
are not designed to take excessive pressure on them.

● Do not bend any cable sharply. A sharp bend can break the internal wires.

● Never bend a SATA data cable tighter than a 30 mm (1.18 in) radius.

● Never crease a SATA data cable.

CAUTION: When disconnecting cables, always pull the connector - NEVER pull on the cable. Pulling
on the cable could damage the cable.

System board connectors are color-coded to make it easier to find the proper connection.

Cable PCA Designator

Hard drive data SATA0 (Dark Blue)

Hard drive power SATA PWR0

Secondary hard drive data SATA1 (Light Blue)

Fan CPUFAN

LED Hard drive LED

Hood sensor HSENSE

Speaker SPKR

USB+PWR 24V and Cash Drawer port daughter card F13:4A/30V

Display P181
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Memory

Description Spare part number

8-GB, PC3-12800 689374-001

4-GB, PC3-12800 689373-001

2-GB, PC3-12800 689372-001

The computer comes with double data rate 3 synchronous dynamic random access memory (DDR3-
SDRAM) dual inline memory modules (DIMMs).

SODIMMs

The memory sockets on the system board can be populated with up to two industry-standard
SODIMMs. These memory sockets are populated with at least one preinstalled SODIMM. To achieve
the maximum memory support, you can populate the system board with up to 8-GB of memory.

DDR3-SDRAM DIMMs

CAUTION: This product DOES NOT support DDR3 Ultra Low Voltage (DDR3U) memory. The
processor is not compatible with DDR3U memory and if you plug DDR3U memory into the system
board, it can cause the physical damage to the SODIMM or invoke system malfunction.

For proper system operation, the SODIMMs must be:

● industry-standard 204-pin

● unbuffered non-ECC PC3-12800 DDR3-1600 MHz-compliant

● 1.5 volt DDR3-SDRAM SODIMMs

The DDR3-SDRAM SODIMMs must also:

● support CAS latency 11 DDR3 1600 MHz (11-11-11 timing)

● contain the mandatory Joint Electronic Device Engineering Council (JEDEC) specification

In addition, the computer supports:

● 512-Mbit, 1-Gbit, 2-Gbit, 4-Gbit, and 8-Gbit non-ECC memory technologies

● single-sided and double-sided SODIMMS

● SODIMMs constructed with x8 and x16 devices; SODIMMs constructed with x4 SDRAM are not
supported

NOTE: The system will not operate properly if you install unsupported SODIMMs.

86 Chapter 8   Removal and Replacement Procedures



Populating DIMM Sockets

There are two SODIMM sockets on the system board, with one socket per channel. The sockets are
labeled DIMM1 and DIMM3. The DIMM1 socket operates in memory channel A. The DIMM3 socket
operates in memory channel B.

The system will automatically operate in single channel mode, dual channel mode, or flex mode,
depending on how the SODIMMs are installed.

● The system will operate in single channel mode if the SODIMM sockets are populated in one
channel only.

● The system will operate in a higher-performing dual channel mode if the memory capacity of the
SODIMM in Channel A is equal to the memory capacity of the SODIMM in Channel B.

● The system will operate in flex mode if the memory capacity of the SODIMM in Channel A is not
equal to the memory capacity of the SODIMM in Channel B. In flex mode, the channel populated
with the least amount of memory describes the total amount of memory assigned to dual channel
and the remainder is assigned to single channel. If one channel will have more memory than the
other, the larger amount should be assigned to channel A.

● In any mode, the maximum operational speed is determined by the slowest SODIMM in the
system.

Installing DIMMs

CAUTION: You must disconnect the power cord and wait approximately 30 seconds for the power
to drain before adding or removing memory modules. Regardless of the power-on state, voltage is
always supplied to the memory modules as long as the computer is plugged into an active AC outlet.
Adding or removing memory modules while voltage is present may cause irreparable damage to the
memory modules or system board.

The memory module sockets have gold-plated metal contacts. When upgrading the memory, it is
important to use memory modules with gold-plated metal contacts to prevent corrosion and/or
oxidation resulting from having incompatible metals in contact with each other.

Static electricity can damage the electronic components of the computer or optional cards. Before
beginning these procedures, ensure that you are discharged of static electricity by briefly touching a
grounded metal object. For more information, refer to Electrostatic Discharge Information on page 40.

When handling a memory module, be careful not to touch any of the contacts. Doing so may damage
the module.

1. Prepare the computer for disassembly (Preparation for Disassembly on page 46).

2. Remove the rear I/O panel (Rear I/O Panel on page 49).

3. Remove the display head back panel (Display Head Back Panel on page 54).
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4. Press down on the lever at the to of the memory access door (1) and rotate the door open (2).

5. To remove a SODIMM, press outward on the two latches on each side of the SODIMM (1) then
pull the SODIMM out of the socket (2).
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6. To install a SODIMM, slide the new SODIMM into the socket at approximately a 30° angle (1)
then press the SODIMM down into the socket (2) so that the latches lock it in place.

NOTE: A memory module can be installed in only one way. Match the notch on the module with
the tab on the memory socket.

7. Close the memory access door.

The computer should automatically recognize the additional memory the next time you turn on the
computer.
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Hard Drive

Description Spare part number

500 GB, 7200 rpm SATA hard drive 686217-001

320 GB, 7200 rpm SATA hard drive 639135-001

256 GB Solid State Drive (SSD) 661842-001

128 GB Solid State Drive (SSD) 665961-001

64 GB Solid State Drive (SSD) 711906-001

32 GB MLC Flash, 2.5-in 686616-001

Grommet, hard drive 594220-001

CAUTION: If you are replacing a hard drive, be sure to back up the data from the old drive so that
you can transfer the data to the new drive.

1. Prepare the computer for disassembly (Preparation for Disassembly on page 46).

2. Remove the rear I/O panel (Rear I/O Panel on page 49).

3. Remove the display head back panel (Display Head Back Panel on page 54).

4. Open the hard drive door (1), then grasp the pull tab on the side of the hard drive and pull the
hard drive out of the drive bay (2).
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5. Remove the four screws from the sides of the hard drive carrier (1) and lift the hard drive out of
the carrier (2).

6. Place the new hard drive into the carrier (1) and install the four screws into the sides of the carrier
(2).
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7. Slide the hard drive/carrier assembly into the drive bay (1) and close the hard drive door (2).

8. Slide the display head's back panel down onto the rear of the display head.
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9. Replace the rear I/O cover by placing the hooks on the bottom of the cover into the slots on the
bottom of the chassis (1). Then rotate the top of the I/O cover up so that it snaps securely onto the
chassis (2).

10. Reconnect the power cord and press the power button.
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Removing the Display Head from the Stand
1. Prepare the computer for disassembly (Preparation for Disassembly on page 46).

2. Remove the rear I/O panel (Rear I/O Panel on page 49).

3. Remove the mounting bracket cover (Mounting Bracket Cover on page 53).

4. Remove the display head back panel (Display Head Back Panel on page 54).

5. Remove the RP7 display head from the stand by removing the three screws that attach the stand's
mounting bracket to the display head (1) then slide the display up and off the mounting bracket
(2).

To remove the display head back panel, reverse the installation procedures.
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Rear Metal Plate (EMI shield)

Description Spare part number

Rear metal plate (EMI shield) 702780-001

1. Prepare the computer for disassembly (Preparation for Disassembly on page 46).

2. Remove the rear I/O panel (Rear I/O Panel on page 49).

3. Remove the mounting bracket cover (Mounting Bracket Cover on page 53).

4. Remove the display head back panel (Display Head Back Panel on page 54).

5. Remove the display head from the stand (Removing the Display Head from the Stand on page 94).

6. Open the memory access door (1), disconnect the DisplayPort power cable (2) and signal cable
(3), then swing the antenna bracket out away from the chassis (4).
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7. Remove the five Torx screws that secure the metal plate on the back of the display head (1) and
lift the metal plate off the display head (2).

To install the rear metal plate, reverse the removal procedures.
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Battery
The battery that comes with the computer provides power to the real-time clock. When replacing the
battery, use a battery equivalent to the battery originally installed in the computer. The computer comes
with a 3-volt lithium coin cell battery.

WARNING! The computer contains an internal lithium manganese dioxide battery. There is a risk of
fire and burns if the battery is not handled properly. To reduce the risk of personal injury:

Do not attempt to recharge the battery.

Do not expose to temperatures higher than 60°C (140ºF).

Do not disassemble, crush, puncture, short external contacts, or dispose of in fire or water.

Replace the battery only with the HP spare designated for this product.

CAUTION: Before replacing the battery, it is important to back up the computer CMOS settings.
When the battery is removed or replaced, the CMOS settings will be cleared.

Static electricity can damage the electronic components of the computer or optional equipment. Before
beginning these procedures, ensure that you are discharged of static electricity by briefly touching a
grounded metal object.

NOTE: The lifetime of the lithium battery can be extended by plugging the computer into a live AC
wall socket. The lithium battery is only used when the computer is NOT connected to AC power.

HP encourages customers to recycle used electronic hardware, HP original print cartridges, and
rechargeable batteries. For more information about recycling programs, go to http://www.hp.com/
recycle.

1. Prepare the computer for disassembly (Preparation for Disassembly on page 46).

2. Remove the rear I/O panel (Rear I/O Panel on page 49).

3. Remove the mounting bracket cover (Mounting Bracket Cover on page 53).

4. Remove the display head back panel (Display Head Back Panel on page 54).

5. Remove the display head from the stand (Removing the Display Head from the Stand on page 94).

6. Lay the display head face down on a surface covered by a clean, dry cloth.

7. Remove the rear metal plate (Rear Metal Plate (EMI shield) on page 95).
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8. Note which side of the battery is the positive side so that the new battery has the same orientation
and pull the battery out of its holder.

9. Insert the new battery. Ensure that the positive side of the new battery is oriented in the same
direction as the battery that was removed.

10. Reverse the removal procedures.
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Blower

Description Spare part number

Blower 702774-001

1. Prepare the computer for disassembly (Preparation for Disassembly on page 46).

2. Remove the rear I/O panel (Rear I/O Panel on page 49).

3. Remove the mounting bracket cover (Mounting Bracket Cover on page 53).

4. Remove the display head back panel (Display Head Back Panel on page 54).

5. Remove the display head from the stand (Removing the Display Head from the Stand on page 94).

6. Remove the rear metal plate (Rear Metal Plate (EMI shield) on page 95).

7. Remove the three Torx screws (1) that secure the blower to the computer.

8. Disconnect the blower control cable from the system board connector labeled CPUFAN (2).

Figure 8-1  Removing the blower screws and disconnecting the cable
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9. Swing the antenna bracket out of the way.

Figure 8-2  Swinging the antenna bracket out of the way

10. Lift the blower straight up and out of the chassis.

Figure 8-3  Removing the blower

To install the blower, reverse the removal procedures.
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Associate-Facing Display (AFD)

Description Spare part number

Display, associate-facing (AFD), 15 inch capacitive 667839-001

Display, associate-facing (AFD), 15 inch resistive 667838-001

Display, associate-facing (AFD), 17 inch capacitive 667841-001

1. Prepare the computer for disassembly (Preparation for Disassembly on page 46).

2. Remove the base unit from the stand (Removing the Display Head from the Stand on page 94).

3. Remove the rear cover (Display Head Back Panel on page 54).

4. Remove the EMI shield (Rear Metal Plate (EMI shield) on page 95).

5. Remove the blower (Blower on page 99).

6. Remove the fingerprint reader (Optional Integrated USB Modules on page 63).

7. Remove the magnetic stripe reader (MSR) (Optional Integrated USB Modules on page 63).

8. Remove the webcam (Optional Integrated USB Modules on page 63).

9. Disconnect the display power cable from the system board (1).

10. Pull up on the yellow Mylar tab to lift the display signal cable locking bar (2), and then disconnect
the display signal cable from the system board (3).
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11. Loosen the two captive Torx T15 screws that secure the chassis base pan near the upper corners
of the display (1), slide the chassis pan toward the bottom of the display (2), and then lift it off the
display (3).

To install the AFD, reverse the removal procedures.
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Heat Sink

Description Spare part number

Heat sink 702773-001

All heat sink spare part kits contain replacement thermal material.

1. Prepare the computer for disassembly (Preparation for Disassembly on page 46).

2. Remove the rear I/O panel (Rear I/O Panel on page 49).

3. Remove the mounting bracket cover (Mounting Bracket Cover on page 53).

4. Remove the display head back panel (Display Head Back Panel on page 54).

5. Remove the display head from the stand (Removing the Display Head from the Stand on page 94).

6. Remove the rear metal plate (Rear Metal Plate (EMI shield) on page 95).

7. Loosen the four captive screws that secure the heat sink to the system board.

Figure 8-4  Loosening the heat sink screws
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8. Lift the heat sink from atop the processor and set it on its side to keep from contaminating the work
area with thermal grease.

Figure 8-5  Removing the heat sink

When reinstalling the heat sink, make sure that its bottom has been cleaned with an alcohol wipe and
fresh thermal grease has been applied to the top of the processor.

CAUTION: Tighten heat sink retaining screws in the order stamped on the heat sink.

104 Chapter 8   Removal and Replacement Procedures



Processor

Description Spare part number

Intel Core i5 2400S processor, 2.5 GHz, 65W 640953-001

Intel Core i3 2120 processor, 3.3 GHz, 65W 638629-001

Intel Pentium Dual-Core G850 processor, 2.9 GHz, 65W 655973-001

Intel Celeron G540 processor, 2.5 GHz 665119-001

1. Prepare the computer for disassembly (Preparation for Disassembly on page 46).

2. Remove the rear I/O panel (Rear I/O Panel on page 49).

3. Remove the mounting bracket cover (Mounting Bracket Cover on page 53).

4. Remove the display head back panel (Display Head Back Panel on page 54).

5. Remove the display head from the stand (Removing the Display Head from the Stand on page 94).

6. Remove the rear metal plate (Rear Metal Plate (EMI shield) on page 95).

7. Remove the heat sink (Heat Sink on page 103).

8. Rotate the locking lever to its full open position (1).

9. Raise and rotate the microprocessor retainer to its fully open position (2).

10. Carefully lift the processor from the socket (3).

CAUTION: Do NOT handle the pins in the processor socket. Once pins are damaged it may be
necessary to replace the system board.

Figure 8-6  Removing the Processor
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NOTE: After installing a new processor onto the system board, always update the system ROM to
ensure that the latest version of the BIOS is being used on the computer. The latest system BIOS can be
found on the Web at: http://h18000.www1.hp.com/support/files.

Drive Cables and Bracket Assembly

Description Spare part number

Drive cables and bracket assembly 702776-001

1. Prepare the computer for disassembly (Preparation for Disassembly on page 46).

2. Remove the rear I/O panel (Rear I/O Panel on page 49).

3. Remove the mounting bracket cover (Mounting Bracket Cover on page 53).

4. Remove the display head back panel (Display Head Back Panel on page 54).

5. Remove the display head from the stand (Removing the Display Head from the Stand on page 94).

6. Remove the rear metal plate (Rear Metal Plate (EMI shield) on page 95).

7. Remove the drive data cables from the clips on the cage (1).

8. Remove the antenna cables from the clip on the cage (2).

9. Remove the Torx screw (3) that secures the cage to the computer.

Figure 8-7  Removing the screw and the cables from the clips
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10. Disconnect the drive data cables and power cable.

Figure 8-8  Disconnecting the drive cables from the system board

11. Remove the drive cage and cable assembly from the computer.

12. Remove the two Torx screws that secure the drive connector to the cage, remove the wires from the
slots in the cage, and then remove the drive connector from the cage.

Figure 8-9  Removing the connector

Drive Cables and Bracket Assembly 107



13. Remove the two Torx screws that secure the drive connector to the cage, remove the cable from
the clip on the cage, and then remove the drive connector from the cage.

Figure 8-10  Removing the drive connector

To reinstall the drive cable and bracket assembly, reverse the removal procedure.
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Hood Sensor

Description Spare part number

Hood sensor 702772-001

1. Prepare the computer for disassembly (Preparation for Disassembly on page 46).

2. Remove the rear I/O panel (Rear I/O Panel on page 49).

3. Remove the mounting bracket cover (Mounting Bracket Cover on page 53).

4. Remove the display head back panel (Display Head Back Panel on page 54).

5. Remove the display head from the stand (Removing the Display Head from the Stand on page 94).

6. Remove the rear metal cover (Rear Metal Plate (EMI shield) on page 95).

7. Disconnect the cable from the system board connector labeled HSENSE (1).

8. Remove the cable from the clip on top of the serial port board (2).
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9. Lift the hood sensor and cable from the computer (3).

Figure 8-11  Removing the hood sensor

To reinstall the front USB and power switch, reverse the removal procedure.
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Hard Drive LED Cable

Description Spare part number

Hard drive LED cable 702777-001

1. Prepare the computer for disassembly (Preparation for Disassembly on page 46).

2. Remove the rear I/O panel (Rear I/O Panel on page 49).

3. Remove the mounting bracket cover (Mounting Bracket Cover on page 53).

4. Remove the display head back panel (Display Head Back Panel on page 54).

5. Remove the display head from the stand (Removing the Display Head from the Stand on page 94).

6. Remove the rear metal plate (Rear Metal Plate (EMI shield) on page 95).

7. Disconnect the cable from the system board connector labeled LED CR14(1).

8. Remove the cable from the routing path (2).

9. Remove the cable from the clips (3).

10. Lift the LED from the holder, and remove the assembly from the computer (4).

Figure 8-12  Removing the hard drive LED cable

To reinstall the hard drive LED cable, reverse the removal procedure.
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Speaker

Description Spare part number

Speaker 730571-001

1. Prepare the computer for disassembly (Preparation for Disassembly on page 46).

2. Remove the rear I/O panel (Rear I/O Panel on page 49).

3. Remove the mounting bracket cover (Mounting Bracket Cover on page 53).

4. Remove the display head back panel (Display Head Back Panel on page 54).

5. Remove the display head from the stand (Removing the Display Head from the Stand on page 94).

6. Remove the rear metal plate (Rear Metal Plate (EMI shield) on page 95).

7. Remove the two Phillips screws (1) that secure the speaker to the computer.

8. Remove the cable from the clip (2).

9. Disconnect the cable from the system board connector labeled SPKR (3).

Figure 8-13  Removing the speaker

10. Remove the speaker from the computer.

To install the speaker, reverse the removal procedures.
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USB+PWR 24V and Cash Drawer Port Daughter
Card

Description Spare part number

USB+PWR 24V and Cash Drawer port daughter card 702775-001

1. Prepare the computer for disassembly (Preparation for Disassembly on page 46).

2. Remove the rear I/O panel (Rear I/O Panel on page 49).

3. Remove the mounting bracket cover (Mounting Bracket Cover on page 53).

4. Remove the display head back panel (Display Head Back Panel on page 54).

5. Remove the display head from the stand (Removing the Display Head from the Stand on page 94).

6. Remove the rear metal plate (Rear Metal Plate (EMI shield) on page 95).

7. Remove the hood sensor cable from the clip on top of the card (1).

8. Remove the two Torx screws (2) that secure the card to the system board.

9. Lift the card straight up to disconnect it from the system board connector (3), and then remove it
from the computer.

Figure 8-14  Removing the USB+PWR 24V and Cash Drawer port daughter card

To install the USB+PWR 24V and Cash Drawer port daughter card, reverse the removal procedure.
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WLAN Module

Description Spare part number

HP WLAN 802.11 a/b/g/n 2x2 PCIe module 695915-001

Intel 640x 802.11 a/b/g/n PCIe module 717382-001

1. Prepare the computer for disassembly (Preparation for Disassembly on page 46).

2. Remove the rear I/O panel (Rear I/O Panel on page 49).

3. Remove the mounting bracket cover (Mounting Bracket Cover on page 53).

4. Remove the display head back panel (Display Head Back Panel on page 54).

5. Remove the display head from the stand (Removing the Display Head from the Stand on page 94).

6. Remove the rear metal plate (Rear Metal Plate (EMI shield) on page 95).

7. Remove the antenna cables from the connectors on the WLAN module (1).

8. Remove the Phillips screw (2) that secures the module to the system board.

9. Rotate the top of the module upward (3), and then pull it away from the slot.

Figure 8-15  Removing the WLAN module

To install the WLAN module, reverse the removal procedure.
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System Board

Description Spare part number

System board for use in models without Windows 8 operating systems (includes thermal material) 674783-001

System board for use in models with Windows 8.1 Professional (includes thermal material) 674783-601

System board for use in models with Windows Embedded 8.1 Industry (includes thermal material) 674783-701

1. Prepare the computer for disassembly (Preparation for Disassembly on page 46).

2. When replacing the system board, make sure the following components are removed from the
defective system board and installed on the replacement system board:

● Memory modules (Memory on page 86)

● Serial port board (USB+PWR 24V and Cash Drawer Port Daughter Card on page 113)

● WLAN (WLAN Module on page 114)

● Processor (Processor on page 105)

● Heat sink (Heat Sink on page 103)

● Processor (Processor on page 105)

3. Remove the rear I/O panel (Rear I/O Panel on page 49).

4. Remove the mounting bracket cover (Mounting Bracket Cover on page 53).

5. Remove the display head back panel (Display Head Back Panel on page 54).

6. Remove the display head from the stand (Removing the Display Head from the Stand on page 94).

7. Remove the rear metal plate (Rear Metal Plate (EMI shield) on page 95).

8. Disconnect all data, power, and any other cables from the system board.

9. Remove the four Torx screws that secure the system board to the computer.
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10. Lift the system board up and out of the chassis.

Figure 8-16  Removing the system board

To install the system board, reverse the removal procedure.
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A Backing up, restoring, and
recovering in Windows 7 and
POSReady 7

Your computer includes tools provided by HP and Windows to help you safeguard your information
and retrieve it if you ever need to. These tools will help you return your computer to a proper working
state or even back to the original factory state, all with simple steps.

This section provides information about the following processes:

● Creating recovery media and backups

● Restoring and recovering your system

NOTE: This section describes an overview of backing up, restoring, and recovering options. For more
details about the Windows Backup and Restore tools provided, see Help and Support. To access Help
and Support, select Start > Help and Support.

Recovery after a system failure is only as good as your most recent backup.

1. After you successfully set up the computer, create recovery media. This media can be used to
reinstall the original operating system in cases where the hard drive is corrupted or has been
replaced. See Creating recovery media on page 118.

2. As you add hardware and software programs, create system restore points. A system restore point
is a snapshot of certain hard drive contents saved by Windows System Restore at a specific time.
A system restore point contains information that Windows uses, such as registry settings. Windows
creates a system restore point for you automatically during a Windows update and during other
system maintenance (such as a software update, security scanning, or system diagnostics). You
can also manually create a system restore point at any time. For more information and steps for
creating specific system restore points, see Help and Support. To access Help and Support, select
Start > Help and Support.

3. As you add photos, video, music, and other personal files, create a backup of your personal
information. If files are accidentally deleted from the hard drive and they can no longer be
restored from the Recycle Bin, or if files become corrupted, you can restore the files that you
backed up. In case of system failure, you can use the backup files to restore the contents of your
computer. See Backing up your information on page 120.

NOTE: HP recommends that you print the recovery procedures and save them for later use, in case of
system instability.
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Creating recovery media
After you successfully set up the computer, create recovery media. The media can be used to reinstall
the original operating system in cases where the hard drive is corrupted or has been replaced.

There are two types of recovery media. To determine which steps to follow for your computer:

1. Click the Start button.

2. Click All Programs.

● If Security and Protection is listed, continue with the steps in Creating recovery media
using HP Recovery Manager (select models only) on page 118.

● If Productivity and Tools is listed, continue with the steps in Creating recovery discs with
HP Recovery Disc Creator (select models only) on page 119.

Creating recovery media using HP Recovery Manager (select
models only)

● To create recovery discs, your computer must have a DVD writer. Use DVD+R or DVD-R discs
(purchased separately). The discs you use will depend on the type of optical drive you are using.

NOTE: DVD+R DL, DVD-R DL, or DVD±RW disc are not supported.

● You have the option of creating a recovery USB flash drive instead, using a high-quality USB
drive.

● If you are creating recovery discs, be sure to use high-quality discs. It is normal for the system to
reject defective discs. You will be prompted to insert a new blank disc to try again.

● The number of discs in the recovery-disc set depends on your computer model (typically 3 to 6
DVDs). The Recovery Media Creation program tells you the specific number of blank discs needed
to make the set. If you are using a USB flash drive, the program will tell you the size of the drive
required to store all the data (minimum of 8 GB).

NOTE: The process of creating recovery media is lengthy. You can quit the process at any time.
The next time you initiate the process, it resumes where it left off.

NOTE: Do not use media cards for creating recovery media. The system may not be able to boot up
from a media card and you may not be able to run system recovery.

To create recovery discs:

1. Close all open programs.

2. Click the Start button, click All Programs, click Security and Protection, click Recovery
Manager, and then click HP Recovery Media Creation. If prompted, click Yes to allow the
program to continue.
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3. Click Create recovery media using blank DVD(s), and then click Next.

4. Follow the on-screen instructions. Label each disc after you make it (for example, Recovery 1,
Recovery 2), and then store the discs in a secure place.

To create a recovery USB flash drive:

NOTE: You must use a USB flash drive with a capacity of at least 8 GB.

NOTE: Recovery Media Creation formats the USB flash drive, deleting any files on it.

1. Close all open programs.

2. Insert the USB flash drive into a USB port on the computer.

3. Click the Start button, click All Programs, click Security and Protection, click Recovery
Manager, and then click Recovery Media Creation.

4. Click Create recovery media with a USB flash drive, and then click Next.

5. Select the USB flash drive from the list of media. The program will let you know how much storage
is required to create the recovery drive. If the USB flash drive does not have enough storage
capacity, it will appear grayed out, and you must replace it with a larger USB flash drive. Click
Next.

6. Follow the on-screen instructions. When the process is complete, label the USB flash drive and
store it in a secure place.

Creating recovery discs with HP Recovery Disc Creator (select
models only)

HP Recovery Disc Creator is a software program that offers an alternative way to create recovery discs
on select models. After you successfully set up the computer, you can create recovery discs using HP
Recovery Disc Creator. The recovery discs allow you to reinstall your original operating system as well
as select drivers and applications if the hard drive becomes corrupted. HP Recovery Disc Creator
creates two kinds of recovery discs:

● Operating system DVD—Installs the operating system without additional drivers or applications.

● Driver Recovery DVD—Installs specific drivers and applications only, in the same way that the HP
Software Setup utility installs drivers and applications.

To create recovery discs, your computer must have a DVD writer. Use any of the following types of
discs (purchased separately): DVD+R, DVD+R DL, DVD-R, DVD-R DL, or DVD±RW. The discs you use
will depend on the type of optical drive you are using.

Creating recovery discs

NOTE: The operating system DVD can be created only once. The option to create that media will not
be available after you create a Windows DVD.
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To create the Windows DVD:

1. Select Start > All Programs > Productivity and Tools > HP Recovery Disc Creator.

2. Select Windows disk.

3. From the drop-down menu, select the drive for burning the recovery media.

4. Click the Create button to start the burning process. Label the disc after you create it, and store it
in a secure place.

After the operating system DVD has been created, create the Driver Recovery DVD:

1. Select Start > All Programs > Productivity and Tools > HP Recovery Disc Creator.

2. Select Driver disk.

3. From the drop-down menu, select the drive for burning the recovery media.

4. Click the Create button to start the burning process. Label the disc after you create it, and store it
in a secure place.

Backing up your information

You should create your initial backup immediately after initial system setup. As you add new software
and data files, you should continue to back up your system on a regular basis to maintain a reasonably
current backup. Your initial and subsequent backups allow you to restore your data and settings if a
failure occurs.

You can back up your information to an optional external hard drive, a network drive, or discs.

Note the following when backing up:

● Store personal files in the Documents library, and back it up regularly.

● Back up templates that are stored in their associated directories.

● Save customized settings that appear in a window, toolbar, or menu bar by taking a screen shot
of your settings. The screen shot can be a time-saver if you have to reset your preferences.

● When backing up to discs, number each disc after removing it from the drive.

NOTE: For detailed instructions on various backup and restore options, perform a search for these
topics in Help and Support. To access Help and Support, select Start > Help and Support.

NOTE: You may be prompted by User Account Control for your permission or password when you
perform certain tasks. To continue a task, select the appropriate option. For information about User
Account Control, see Help and Support: Select Start > Help and Support.

To create a backup using Windows Backup and Restore:
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NOTE: The backup process may take over an hour, depending on file size and the speed of the
computer.

1. Select Start > All Programs > Maintenance > Backup and Restore.

2. Follow the on-screen instructions to set up your backup.

System Restore
If you have a problem that might be due to software that you installed on your computer, or if you want
to restore the system to a previous state without losing any personal information, use System Restore to
return the computer to a previous restore point.

NOTE: Always use this System Restore procedure before you use the System Recovery feature.

To start System Restore:

1. Close all open programs.

2. Click the Start button, right-click Computer, and then click Properties.

3. Click System protection, System Restore, click Next, and then follow the on-screen
instructions.

System Recovery
WARNING! This procedure will delete all user information. To prevent loss of information, be sure to
back up all user information so you can restore it after recovery.

System Recovery completely erases and reformats the hard disk drive, deleting all data files that you
have created, and then reinstalls the operating system, programs, and drivers. However, you must
reinstall any software that was not installed on the computer at the factory. This includes software that
came on media included in the computer accessory box, and any software programs you installed after
purchase. Any personal files must be restored from backups you made.

If you were not able to create system recovery DVDs or USB flash drive, you can order a recovery disc
set from support. Go to http://www.hp.com/support, select your country or region, and follow the on-
screen instructions.

NOTE: Always use the System Restore procedure before you use the System Recovery program. See
System Restore on page 121.

You must choose one of the following methods to perform a System Recovery:

● Recovery image — Run System Recovery from a recovery image stored on your hard disk drive.
The recovery image is a file that contains a copy of the original factory-shipped software. To
perform a System Recovery from a recovery image, see System Recovery when Windows is
responding on page 122 or System Recovery when Windows is not responding on page 122.

● Recovery media — Run System Recovery from recovery media that you have created from files
stored on your hard disk drive or purchased separately. See System Recovery using recovery
media (select models only) on page 123.
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System Recovery when Windows is responding

CAUTION: System Recovery deletes all data and programs you created or installed. Before you
begin, back up any important data to a CD or DVD or to a USB flash drive.

NOTE: In some cases, you must use recovery media for this procedure. If you have not already
created this media, follow the instructions in Creating recovery media on page 118.

If the computer is working and the operating system is responding, use these steps to perform a System
Recovery:

1. Turn off the computer.

2. Disconnect all peripheral devices from the computer except the monitor, keyboard, and mouse.

3. Turn on the computer.

4. When Windows has loaded, click the Start button, and then click All Programs.

● If Security and Protection is listed, continue with step 5.

● If Productivity and Tools is listed, follow the steps in System Recovery when Windows is
not responding on page 122.

5. Click Security and Protection, click Recovery Manager, and then click Recovery
Manager. If prompted, click Yes to allow the program to continue.

6. Under I need help immediately, click System Recovery.

7. Select Yes, and then click Next. Your computer restarts.

8. When the computer restarts, you will see the Recovery Manager welcome screen again. Under I
need help immediately, click System Recovery. If you are prompted to back up your files,
and you have not done so, select Back up your files first (recommended), and then click
Next. Otherwise, select Recover without backing up your files, and then click Next.

9. System Recovery begins. After System Recovery is complete, click Finish to restart the computer.

10. When Windows has loaded, shut down the computer, reconnect all peripheral devices, and then
turn the computer back on.

System Recovery when Windows is not responding

CAUTION: System Recovery deletes all data and programs you created or installed.

If Windows is not responding, but the computer is working, follow these steps to perform a System
Recovery.

1. Turn off the computer. If necessary, press and hold the power button until the computer turns off.

2. Disconnect all peripheral devices from the computer, except the monitor, keyboard, and mouse.

3. Press the power button to turn on the computer.
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4. As soon as you see the HP logo screen, repeatedly press the F11 key on your keyboard until the
Windows is Loading Files… message appears on the screen.

5. At the HP Recovery Manager screen, follow the on-screen instructions to continue.

6. When Windows has loaded, shut down the computer, reconnect all peripheral devices, and then
turn the computer back on.

System Recovery using recovery media (select models only)

Use the steps provided in this section if you created recovery media using Creating recovery media
using HP Recovery Manager (select models only) on page 118. If you used HP Recovery Disc Creator
to create an operating system DVD and a Driver Recovery DVD, use the steps in Using HP Recovery
Disc operating system discs (select models only) on page 124.

CAUTION: System Recovery deletes all data and programs you have created or installed. Back up
any important data to a CD or DVD or to a USB flash drive.

To perform a System Recovery using recovery media:

1. If you are using a set of DVDs, insert the first recovery disc into the DVD drive tray, and close the
tray. If you are using a recovery USB flash drive, insert it into a USB port.

2. Click the Start button, and then click Shut Down.

or

If the computer is not responding, press and hold the power button for approximately 5 seconds or
until the computer turns off.

3. Disconnect all peripheral devices from the computer except the monitor, keyboard, and mouse.

4. Press the power button to turn on the computer, and press Esc as the computer is powering on to
display the startup menu.

5. Use the arrow keys to select the boot menu, and press Enter. Use the arrow keys to select the
location where the recovery media is inserted (USB or DVD). Press Enter to boot from that device.

6. If Recovery Manager asks if you want to run System Recovery from Media or Hard Drive, select
Media. On the Welcome screen, under I need help immediately, click Factory Reset.

7. If you are prompted to back up your files, and you have not done so, select Back up your files
first (recommended), and then click Next. Otherwise, select Recover without backing
up your files, and then click Next.

8. If you are prompted to insert the next recovery disc, do so.

9. When Recovery Manager is finished, remove the recovery disc or the recovery USB flash drive
from the system.

10. Click Finish to restart the computer.

System Recovery 123



Using HP Recovery Disc operating system discs (select models only)

Use the steps provided in this section if you used HP Recovery Disc Creator to create an operating
system DVD and a Driver Recovery DVD. If you created recovery media using Creating recovery media
using HP Recovery Manager (select models only) on page 118. use the steps in System Recovery using
recovery media (select models only) on page 123.

If you cannot use the recovery discs you previously created using the HP Recovery Disc Creator (select
models only), you must purchase an operating system DVD to reboot the computer and repair the
operating system.

To order an operating system DVD, contact support. Go to http://www.hp.com/support, select your
country or region, and follow the on-screen instructions.

CAUTION: Using a Windows 7 or POSReady operating system DVD completely erases the hard
drive contents and reformats the hard drive. All files that you have created and any software that you
have installed on the computer are permanently removed. When reformatting is complete, the recovery
process helps you restore the operating system, as well as drivers, software, and utilities.

To initiate recovery using a Windows 7 or POSReady operating system DVD:

NOTE: This process takes several minutes.

1. If possible, back up all personal files.

2. Restart the computer, and then insert the operating system DVD into the optical drive before the
Windows operating system loads.

NOTE: If the computer does not boot to the DVD, restart the computer and press Esc as the
computer is powering on to see the startup menu. Use the arrow keys to select the boot menu and
press Enter. Use the arrow keys to select the location where the recovery DVD is inserted. Press
Enter to boot from that device.

3. When prompted, press any keyboard key.

4. Follow the on-screen instructions.

5. Click Next.

6. Select Install now.

7. Follow the on-screen instructions.

After the repair is completed:

1. Eject the operating system DVD and then insert the Driver Recovery DVD.

2. Follow the on-screen instructions to install the Hardware Enabling Drivers first, and then install
Recommended Applications.
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B Backing up, restoring, and
recovering in Windows 8.1,
Windows 8, or Industry 8.1

Your computer includes tools provided by HP and Windows to help you safeguard your information
and retrieve it if you ever need to. These tools will help you return your computer to a proper working
state or even back to the original factory state, all with simple steps.

This section provides information about the following processes:

● Creating recovery media and backups

● Restoring and recovering your system

NOTE: This section describes an overview of backing up, restoring, and recovering options. For more
details about the tools provided, see Help and Support. From the Start screen, type help, and then
select Help and Support.
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Creating recovery media and backups
Recovery after a system failure is only as good as your most recent backup.

1. After you successfully set up the computer, create recovery media. This step creates a backup of
the recovery partition on the computer. The backup can be used to reinstall the original operating
system in cases where the hard drive is corrupted or has been replaced.

NOTE: There is no recovery partition on systems with a 32GB SSD. For those systems, you must
use the recovery media in the box or that can be obtained from HP Services.

You will use a USB flash drive to create a bootable recovery drive that can be used to troubleshoot
a computer that is unable to start. The USB flash drive can be used to reinstall the original
operating system and the programs that were installed at the factory.

NOTE: Any information on the USB flash drive will be erased before the recovery media is
created.

● To create the Windows 8.1 or Industry 8.1 recovery media, from the Start screen, type
recovery drive, then click on Create a recovery drive. Follow the on-screen
instructions to continue.

● To create the Windows 8 recovery media, from the Start screen, type recovery drive,
and then click on Settings, then click on Create a recovery drive. Follow the on-screen
instructions to continue.

2. Use the Windows tools to create system restore points and create backups of personal
information. For more information and steps, see Help and Support. From the Start screen, type
help, and then select Help and Support.
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Restoring and recovering using Windows tools
Windows offers several options for restoring from backup, refreshing the computer, and resetting the
computer to its original state. For more information and steps, see Help and Support. From the Start
screen, type help, and then select Help and Support.

Using Reset when the system is not responding

NOTE: You may be prompted by User Account Control for your permission or password when you
perform certain tasks. To continue a task, select the appropriate option. For information about User
Account Control, see Help and Support. From the Start screen, type help, and then select Help and
Support.

IMPORTANT: Reset does not provide backups of your information. Before using Reset, back up any
personal information you wish to retain.

If Windows recovery steps are not working and the system is not responding, use these steps to start
Reset:

1. If possible, back up all personal files.

2. If possible, check for the presence of the HP Recovery partition:

● For Windows 8.1 or Industry 8.1, from the Start screen, type pc, and then select This PC.

● For Windows 8, from the Start screen, type c, and then select Computer.

NOTE: If the HP Recovery partition is not listed, or you cannot check for its presence, you must
recover using the recovery media you created; see Recovery using the Windows recovery USB
flash drive on page 127. Or you must use the Windows operating system media and the Driver
Recovery media (purchased separately); see Recovery using Windows operating system media
(purchased separately) on page 128.

3. If the HP Recovery partition is listed, restart the computer, and then press esc while the HP logo is
displayed. The computer Startup Menu displays.

4. Press f11 to select the System Recovery option.

5. Choose your keyboard layout.

6. Select Troubleshoot.

7. Select Reset.

8. Follow the on-screen instructions to continue.

Recovery using the Windows recovery USB flash drive

To recover your system using the recovery USB flash drive you previously created:
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NOTE: If you did not create a recovery USB flash drive or the one you created does not work, see
Recovery using Windows operating system media (purchased separately) on page 128.

1. If possible, back up all personal files.

2. Insert the recovery USB flash drive you created into a USB port on your computer.

3. Restart the computer and as soon as you see the HP logo screen, press f9 to display a list of boot
devices. Use the arrow keys to select your USB flash drive from the UEFI Boot Sources list. Press
Enter to boot from that device.

4. Choose your keyboard layout.

5. Select Troubleshoot.

6. Select Refresh your PC.

7. Follow the on-screen instructions.

Recovery using Windows operating system media (purchased
separately)

To order a Windows operating system DVD, contact support. Go to http://www.hp.com/support,
select your country or region, and follow the on-screen instructions.

CAUTION: Using Windows operating system media completely erases the hard drive contents and
reformats the hard drive. All files that you have created and any software that you have installed on the
computer are permanently removed. When reformatting is complete, the recovery process helps you
restore the operating system, as well as drivers, software, and utilities.

To initiate recovery using Windows operating system media:

NOTE: This process takes several minutes.

1. If possible, back up all personal files.

2. Restart the computer, and then follow the instructions provided with the Windows operating system
media to install the operating system.

3. When prompted, press any keyboard key.

4. Follow the on-screen instructions.

After the repair is completed and the Windows desktop appears:

1. Remove the Windows operating system media, and then insert the Driver Recovery media.

2. Install the Hardware Enabling Drivers first, and then install Recommended Applications.
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C Configuring the Software

Touch Screen Calibration
You do not need to install the touch driver software for Microsoft Windows 7 or POSReady 7. Touch
drivers are already included in those operating systems for this monitor.

HP recommends that you calibrate the touch screen before using the system to ensure that the touch
point registers on the screen where the stylus or finger touches the screen. If at any time you find that
the touch point is not registering properly, you may need to repeat the calibration process.

Calibration for Windows 7 and POSReady 7

To calibrate the touch module in Windows 7 and POSReady 7:

1. In the HP factory image, select Start > All Programs > Load Windows Calibration Tool,
then proceed to step 2.

OR

Open the Start menu, tap the Control Panel link and type “calibrate” in the Search box. Under
Tablet PC Settings, tap the Calibrate the screen for pen or touch input link. In the
Tablet PC Settings dialog box, tap the Calibrate button, then proceed to step 2.

2. Follow the on-screen instructions to press the target marks on the touch screen. At the end of the
calibration process, the touch module should be aligned with the video and the touch points will
be accurate.

Calibration for Windows XP

You must load the touch screen driver provided on the software and documentation CD that shipped
with the monitor if you are using Windows XP or a Windows XP based operating system. A Calibration
Tool for Windows XP is also included on the CD shipped with the monitor.

To calibrate the touch module in Windows XP:

1. Install the software from the software and documentation CD and refer to the readme file for
calibration instructions.

2. After installation, launch the software and follow the on screen instructions. At the end of the
calibration process, the touch module should be aligned with the video and the touch points will
be accurate.
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Configuring the MSR and VFD Customer Display
To configure the MSR and VFD, refer to the HP Point of Sale Configuration Guide (available in English
only). The guide is available on the system's hard drive. In Windows XP or Windows Embedded
POSReady 2009, select Start > All Programs > HP Point of Sale Information to access the
guide. In Windows 7 or Windows Embedded POSReady 7, select Start > HP Point of Sale
Information to access the guide.

Configuring Powered Serial Ports
The serial ports can be configured as standard (non-powered) serial ports or powered serial ports.
Some devices use a powered serial port. If the serial port is configured as a powered port, devices that
support a powered serial interface do not require an external power source.

NOTE: The computer ships with all serial ports configured in standard serial mode by default unless
the powered serial port AV numbers are ordered.

The serial ports can be configured using the Computer F10 Setup utility. Under the Onboard Devices
menu, you are given the option to select the following three settings for each individual serial port:

● Standard

● 5v on pins 1 and 9

● 12v on pins 1 and 9

NOTE: To access the Computer F10 Setup utility, restart the computer and press the F10 key as soon
as the HP logo screen is displayed (before the computer boots to the operating system).
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D Power Cord Set Requirements

The power supplies on some computers have external power switches. The voltage select switch feature
on the computer permits it to operate from any line voltage between 100-120 or 220-240 volts AC.
Power supplies on those computers that do not have external power switches are equipped with
internal switches that sense the incoming voltage and automatically switch to the proper voltage.

The power cord set received with the computer meets the requirements for use in the country where you
purchased the equipment.

Power cord sets for use in other countries must meet the requirements of the country where you use the
computer.

General Requirements
The requirements listed below are applicable to all countries:

1. The power cord must be approved by an acceptable accredited agency responsible for evaluation
in the country where the power cord set will be installed.

2. The power cord set must have a minimum current capacity of 10A (7A Japan only) and a nominal
voltage rating of 125 or 250 volts AC, as required by each country’s power system.

3. The diameter of the wire must be a minimum of 0.75 mm2 or 18AWG, and the length of the cord
must be between 1.8 m (6 feet) and 3.6 m (12 feet).

4. A C15 power cord MUST be used.

The power cord should be routed so that it is not likely to be walked on or pinched by items placed
upon it or against it. Particular attention should be paid to the plug, electrical outlet, and the point
where the cord exits from the product.

WARNING! Do not operate this product with a damaged power cord set. If the power cord set is
damaged in any manner, replace it immediately.

Japanese Power Cord Requirements
For use in Japan, use only the power cord received with this product.

CAUTION: Do not use the power cord received with this product on any other products.
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Country-Specific Requirements
Additional requirements specific to a country are shown in parentheses and explained below.

Country Accrediting Agency  Country Accrediting Agency

Australia (1)

Austria (1)

Belgium (1)

Canada (2)

EANSW

OVE

CEBC

CSA

 Italy (1)

Japan (3)

Norway (1)

Sweden (1)

IMQ

METI

NEMKO

SEMKO

Denmark (1)

Finland (1)

France (1)

Germany (1)

DEMKO

SETI

UTE

VDE

 Switzerland (1)

United Kingdom (1)

United States (2)

SEV

BSI

UL

1. The flexible cord must be Type HO5VV-F, 3-conductor, 0.75mm2 conductor size. Power cord set fittings (appliance
coupler and wall plug) must bear the certification mark of the agency responsible for evaluation in the country where it
will be used.

2. The flexible cord must be Type SVT or equivalent, No. 18 AWG, 3-conductor. The wall plug must be a two-pole
grounding type with a NEMA 5-15P (15A, 125V) or NEMA 6-15P (15A, 250V) configuration.

3. Appliance coupler, flexible cord, and wall plug must bear a “T” mark and registration number in accordance with the
Japanese Dentori Law. Flexible cord must be Type VCT or VCTF, 3-conductor, 0.75 mm2 conductor size. Wall plug must
be a two-pole grounding type with a Japanese Industrial Standard C8303 (7A, 125V) configuration.
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E POST Error Messages

This appendix lists the error codes, error messages, and the various indicator light and audible
sequences that you may encounter during Power-On Self-Test (POST) or computer restart, the probable
source of the problem, and steps you can take to resolve the error condition.

POST Message Disabled suppresses most system messages during POST, such as memory count and
non-error text messages. If a POST error occurs, the screen will display the error message. To manually
switch to the POST Messages Enabled mode during POST, press any key (except F10 or F12). The
default mode is POST Message Disabled.

The speed at which the computer loads the operating system and the extent to which it is tested are
determined by the POST mode selection.

Quick Boot is a fast startup process that does not run all of the system level tests, such as the memory
test. Full Boot runs all of the ROM-based system tests and takes longer to complete.

Full Boot may also be enabled to run every 1 to 30 days on a regularly scheduled basis. To establish
the schedule, reconfigure the computer to the Full Boot Every x Days mode, using Computer Setup.

NOTE: For more information on Computer Setup, see the Computer Setup (F10) Utility Guide on the
Documentation and Diagnostics CD.

Power-On Self-Test (POST)
POST is a series of diagnostic tests that runs automatically when the system is turned on. POST checks
the following items to ensure that the computer system is functioning properly:

● Keyboard

● Memory modules

● All mass storage devices

● Processors

● Controllers

NOTE: If the Power-On Password is set, a key icon appears on the screen while POST is running. You
will need to enter the password before continuing.

If POST finds an error in the system, an audible and/or visual message occurs.
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POST Numeric Codes and Text Messages
This section covers those POST errors that have numeric codes associated with them. The section also
includes some text messages that may be encountered during POST.

NOTE: The computer will beep once after a POST text message is displayed on the screen.

Table E-1  Numeric Codes and Text Messages

Control panel message Description Recommended action

101-Option ROM Checksum Error System ROM or expansion board option
ROM checksum.

1. Verify the correct ROM.

2. Flash the ROM if needed.

3. If an expansion board was recently
added, remove it to see if the problem
remains.

4. Clear CMOS.

5. If the message disappears, there may
be a problem with the expansion card.

6. Replace the system board.

103-System Board Failure DMA or timers. 1. Clear CMOS.

2. Remove expansion boards.

3. Replace the system board.

110-Out of Memory Space for Option ROMs Recently added PCI expansion card contains
an option ROM too large to download
during POST.

1. If a PCI expansion card was recently
added, remove it to see if the problem
remains.

2. In Computer Setup, set Advanced >
Device Options > NIC PXE Option
ROM Download to DISABLE to
prevent PXE option ROM for the internal
NIC from being downloaded during
POST to free more memory for an
expansion card's option ROM. Internal
PXE option ROM is used for booting
from the NIC to a PXE server.

3. Ensure the ACPI/USB Buffers @ Top of
Memory setting in Computer Setup is
enabled.
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Table E-1  Numeric Codes and Text Messages (continued)

Control panel message Description Recommended action

162-System Options Not Set Configuration incorrect.

RTC (real-time clock) battery may need to
be replaced.

Run Computer Setup and check the
configuration in Advanced > Onboard
Devices.

Reset the date and time under Control
Panel. If the problem persists, replace the
RTC battery. See the Hardware Reference
Guide on the Documentation and
Diagnostics CD for instructions on installing a
new battery, or contact an authorized dealer
or reseller for RTC battery replacement.

163-Time & Date Not Set Invalid time or date in configuration memory.

RTC (real-time clock) battery may need to
be replaced.

Reset the date and time under Control
Panel (Computer Setup can also be used). If
the problem persists, replace the RTC
battery. See the Hardware Reference Guide
on the Documentation and Diagnostics CD
for instructions on installing a new battery, or
contact an authorized dealer or reseller for
RTC battery replacement.

163-Time & Date Not Set CMOS jumper may not be properly installed. Check for proper placement of the CMOS
jumper if applicable.

164-MemorySize Error Memory amount has changed since the last
boot (memory added or removed).

Press the F1 key to save the memory
changes.

164-MemorySize Error Memory configuration incorrect. 1. Run Computer Setup or Windows
utilities.

2. Make sure the memory module(s) are
installed properly.

3. If third-party memory has been added,
test using HP-only memory.

4. Verify proper memory module type.

201-Memory Error RAM failure. 1. Run Computer Setup or Windows
utilities.

2. Ensure memory modules are correctly
installed.

3. Verify proper memory module type.

4. Remove and replace the identified
faulty memory module(s).

5. If the error persists after replacing
memory modules, replace the system
board.

213-Incompatible Memory Module in
Memory Socket(s) X, X, ...

A memory module in memory socket
identified in the error message is missing
critical SPD information, or is incompatible
with the chipset.

1. Verify proper memory module type.

2. Try another memory socket.

3. Replace DIMM with a module
conforming to the SPD standard.
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Table E-1  Numeric Codes and Text Messages (continued)

Control panel message Description Recommended action

214-DIMM Configuration Warning Populated DIMM Configuration is not
optimized.

Rearrange the DIMMs so that each channel
has the same amount of memory.

219-ECC Memory Module Detected ECC
Modules not supported on this Platform

Recently added memory module(s) support
ECC memory error correction.

1. If additional memory was recently
added, remove it to see if the problem
remains.

2. Check product documentation for
memory support information.

301-Keyboard Error Keyboard failure. 1. Reconnect keyboard with computer
turned off.

2. Check connector for bent or missing
pins.

3. Ensure that none of the keys are
depressed.

4. Replace keyboard.

303-Keyboard Controller Error I/O board keyboard controller. 1. Reconnect keyboard with computer
turned off.

2. Replace the system board.

304-Keyboard or System Unit Error Keyboard failure. 1. Reconnect the keyboard with computer
turned off.

2. Ensure that none of the keys are
depressed.

3. Replace the keyboard.

4. Replace the system board.

404-Parallel Port Address Conflict Detected Both external and internal ports are assigned
to parallel port X.

1. Remove any parallel port expansion
cards.

2. Clear CMOS.

3. Reconfigure card resources and/or run
Computer Setup.

410-Audio Interrupt Conflict IRQ address conflicts with another device. Enter Computer Setup and reset the IRQ in
Advanced > Onboard Devices.

411-Network Interface Card Interrupt
Conflict

IRQ address conflicts with another device. Enter Computer Setup and reset the IRQ in
Advanced > Onboard Devices.

501-Display Adapter Failure Graphics display controller. 1. Reseat the graphics card (if applicable).

2. Clear CMOS.

3. Verify monitor is attached and turned
on.

4. Replace the graphics card (if possible).
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Table E-1  Numeric Codes and Text Messages (continued)

Control panel message Description Recommended action

510-Flash Screen Image Corrupted Flash Screen image has errors. Reflash the system ROM with the latest BIOS
image.

511-CPU, CPUA, or CPUB Fan not Detected CPU fan is not connected or may have
malfunctioned.

1. Reseat CPU fan.

2. Reseat fan cable.

3. Replace CPU fan.

512-Chassis, Rear Chassis, or Front Chassis
Fan not Detected

Chassis, rear chassis, or front chassis fan is
not connected or may have malfunctioned.

1. Reseat chassis, rear chassis, or front
chassis fan.

2. Reseat fan cable.

3. Replace chassis, rear chassis, or front
chassis fan.

514-CPU or Chassis Fan not Detected CPU or chassis fan is not connected or may
have malfunctioned.

1. Reseat CPU or chassis fan.

2. Reseat fan cable.

3. Replace CPU or chassis fan.

610-External Storage Device Failure External tape drive not connected. Reinstall tape drive or press F1 and allow
system to reconfigure without the drive.

611-Primary Floppy Port Address Assignment
Conflict

Configuration error. Run Computer Setup and check the
configuration in Advanced > Onboard
Devices.

660-Display cache is detected unreliable Integrated graphics controller display cache
is not working properly and will be disabled.

Replace system board if minimal graphics
degrading is an issue.

912-Computer Cover Has Been Removed
Since Last System Startup

Computer cover was removed since last
system startup.

No action required.

917-Front Audio Not Connected Front audio harness has been detached or
unseated from motherboard.

Reconnect or replace front audio harness.

918-Front USB Not Connected Front USB harness has been detached or
unseated from motherboard.

Reconnect or replace front USB harness.

921-Device in PCI Express slot failed to
initialize

There is an incompatibility/problem with this
device and the system or PCI Express Link
could not be retrained to an x1.

Try rebooting the system. If the error
reoccurs, the device may not work with this
system

1151-Serial Port A Address Conflict Detected Both external and internal serial ports are
assigned to COM1.

1. Remove any serial port expansion
cards.

2. Clear CMOS.

3. Reconfigure card resources and/or run
Computer Setup or Windows utilities.
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Table E-1  Numeric Codes and Text Messages (continued)

Control panel message Description Recommended action

1152-Serial Port B Address Conflict Detected Both external and internal serial ports are
assigned to COM2.

1. Remove any serial port expansion
cards.

2. Clear CMOS.

3. Reconfigure card resources and/or run
Computer Setup or Windows utilities.

1155-Serial Port Address Conflict Detected Both external and internal serial ports are
assigned to same IRQ.

1. Remove any serial port expansion
cards.

2. Clear CMOS.

3. Reconfigure card resources and/or run
Computer Setup or Windows utilities.

1201-System Audio Address Conflict
Detected

Device IRQ address conflicts with another
device.

Enter Computer Setup and reset the IRQ in
Advanced > Onboard Devices.

1202-MIDI Port Address Conflict Detected Device IRQ address conflicts with another
device.

Enter Computer Setup and reset the IRQ in
Advanced > Onboard Devices.

1203-Game Port Address Conflict Detected Device IRQ address conflicts with another
device.

Enter Computer Setup and reset the IRQ in
Advanced > Onboard Devices.

1720-SMART Hard Drive Detects Imminent
Failure

Hard drive is about to fail. (Some hard
drives have a hard drive firmware patch that
will fix an erroneous error message.)

1. Determine if hard drive is giving correct
error message. Enter Computer Setup
and run the Drive Protection System test
under Storage > DPS Self-test.

2. Apply hard drive firmware patch
if applicable. (Available at
http://www.hp.com/support.)

3. Back up contents and replace hard
drive.

1796-SATA Cabling Error One or more SATA devices are improperly
attached. For optimal performance, the
SATA 0 and SATA 1 connectors must be
used before SATA 2 and SATA 3.

Ensure SATA connectors are used in
ascending order. For one device, use SATA
0. For two devices, use SATA 0 and SATA
1. For three devices, use SATA 0, SATA1,
and SATA 2.

1797-SATA Drivelock is not supported in
RAID mode.

Drivelock is enabled on one or more SATA
hard drives, and they cannot be accessed
while the system is configured for RAID
mode.

Either remove the Drivelocked SATA device
or disable the Drivelock feature. To disable
the Drivelock feature, enter Computer Setup,
change Storage > Storage Options >
SATA Emulation to IDE, and select File >
Save Changes and Exit. Reenter
Computer Setup and select Security >
Drivelock. For each listed Drivelock-
capable SATA device, ensure Drivelock is
Disabled. Lastly, change Storage >
Storage Options > SATA Emulation
back to RAID and select File > Save
Changes and Exit.
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Table E-1  Numeric Codes and Text Messages (continued)

Control panel message Description Recommended action

1801-Microcode Patch Error Processor is not supported by ROM BIOS. 1. Upgrade BIOS to proper version.

2. Change the processor.

Invalid Electronic Serial Number Electronic serial number has become
corrupted.

1. Run Computer Setup. If Setup already
has data in the field or will not allow
the serial number to be entered,
download from http://www.hp.com.

2. Run Computer Setup and try to enter
serial number under Security, System
ID, then save changes.

Memory Parity Error Parity RAM failure.

Third-party graphics card may be causing a
problem.

Run Computer Setup and Diagnostic utilities.
Remove third-party graphics card to see if
the problem goes away.

Network Server Mode Active and No
Keyboard Attached

Keyboard failure while Network Server
Mode enabled.

1. Reconnect keyboard with computer
turned off.

2. Check connector for bent or missing
pins.

3. Ensure that none of the keys are
depressed.

4. Replace keyboard.

Parity Check 2 Parity RAM failure. Third-party graphics card
may be causing a problem.

Run Computer Setup and Diagnostic utilities.
Remove third-party graphics card to see if
the problem goes away.

The system is violating the thermal
environment requirement.

Improper processor installed or add-in card
installed in 50C mode.

1. Replace the processor with a 65-W
processor.

2. Remove any add-in cards.

Interpreting POST Diagnostic Front Panel LEDs and
Audible Codes

This section covers the front panel LED codes as well as the audible codes that may occur before or
during POST that do not necessarily have an error code or text message associated with them.

WARNING! When the computer is plugged into an AC power source, voltage is always applied to
the system board. To reduce the risk of personal injury from electrical shock and/or hot surfaces, be
sure to disconnect the power cord from the wall outlet and allow the internal system components to cool
before touching.
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NOTE: If you see flashing LEDs on a PS/2 keyboard, look for flashing LEDs on the front panel of the
computer and refer to the following table to determine the front panel LED codes.

Recommended actions in the following table are listed in the order in which they should be performed.

Not all diagnostic lights and audible codes are available on all models.

Table E-2  Diagnostic Front Panel LEDs and Audible Codes

Activity Beeps Possible Cause Recommended Action

Green Power LED On. None Computer on. None

Green Power LED flashes. None Computer in Suspend to
RAM mode (some models
only) or normal Suspend
mode.

None required. Press any key if a keyboard is
attached or move the mouse if a mouse is
attached to wake the computer. You can also
wake the computer by pressing the power button
or tapping the touch screen.

Red Power LED flashes two
times, once every second,
followed by a two second
pause. Beeps stop after fifth
iteration but LEDs continue until
problem is solved.

2 Processor thermal
protection activated:

Fan may be blocked or
not turning.

OR

The heatsink/fan assembly
is not properly attached to
the processor.

1. Ensure that the computer air vents are not
blocked and the fan is running.

2. Open the cover, press the power button,
and see if the fan spins. If the fan is not
spinning, make sure the fan's cable is
plugged onto the system board header.

3. If the fan is plugged in, but is not spinning,
then replace heatsink/fan assembly.

4. Contact an authorized reseller or service
provider.

Red Power LED flashes three
times, once every second,
followed by a two second
pause. Beeps stop after fifth
iteration but LEDs continue until
problem is solved.

3 Processor not installed (not
an indicator of bad
processor).

1. Check to see that the processor is present.

2. Reseat the processor.

Red Power LED flashes four
times, once every second,
followed by a two second
pause. Beeps stop after fifth
iteration but LEDs continue until
problem is solved.

4 Power failure (power
supply is overloaded).

1. Ensure the DC power cable is plugged into
the I/O panel.

2. Check if a device is causing the problem by
removing ALL attached devices (such as a
hard drive). Power on the system. If the
system enters the POST, then power off and
replace the device to see if the problem is
resolved.

3. Replace the power supply.

4. Replace the system board.
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Table E-2  Diagnostic Front Panel LEDs and Audible Codes (continued)

Activity Beeps Possible Cause Recommended Action

Red Power LED flashes five
times, once every second,
followed by a two second
pause. Beeps stop after fifth
iteration but LEDs continue until
problem is solved.

5 Pre-video memory error. CAUTION: To avoid damage to the SODIMMs
or the system board, you must unplug the
computer power cord before attempting to reseat,
install, or remove a SODIMM module.

1. Reseat SODIMMs.

2. Replace SODIMMs one at a time to isolate
the faulty module.

3. Replace third-party memory with HP
memory.

4. Replace the system board.

Red Power LED flashes six
times, once every second,
followed by a two second
pause. Beeps stop after fifth
iteration but LEDs continue until
problem is solved.

6 Pre-video graphics error. 1. Unplug the power cord. Press the CMOS
reset button. Install the FDO jumper to
disable ME (or remove the FDO jumper to
disable ME if it was installed).

2. Replace the system board.

Red Power LED flashes seven
times, once every second,
followed by a two second
pause. Beeps stop after fifth
iteration but LEDs continue until
problem is solved.

7 System board failure
(ROM detected failure
prior to video).

Replace the system board.

Red Power LED flashes eight
times, once every second,
followed by a two second
pause. Beeps stop after fifth
iteration but LEDs continue until
problem is solved.

8 Invalid ROM based on
bad checksum.

1. Reflash the system ROM with the latest BIOS
image.

2. Replace the system board.

Red Power LED flashes nine
times, once every second,
followed by a two second
pause. Beeps stop after fifth
iteration but LEDs continue until
problem is solved.

9 System powers on but is
unable to boot.

1. Replace the processor.

2. Replace the system board.
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Table E-2  Diagnostic Front Panel LEDs and Audible Codes (continued)

Activity Beeps Possible Cause Recommended Action

Power LED flashes 12 times,
once every second, followed
by a two second pause. Beeps
stop after third iteration and
the computer reboots.

12 Health timer expired. None.

System does not power on and
LEDs are not flashing.

None System unable to power
on.

Press and hold the power button for less than 4
seconds. If the hard drive LED turns green, the
power button is working correctly. Replace the
system board.

OR

Press and hold the power button for less than 4
seconds. If the hard drive LED does not turn on
green then:

1. Check that the unit is plugged into a
working AC outlet.

2. Ensure that the DC power cable is plugged
into the I/O panel.

3. Replace the power supply.
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F Password Security and Resetting
CMOS

This computer supports security password features, which can be established through the Computer
Setup Utilities menu.

This computer supports two security password features that are established through the Computer Setup
Utilities menu: setup password and power-on password. When you establish only a setup password,
any user can access all the information on the computer except Computer Setup. When you establish
only a power-on password, the power-on password is required to access Computer Setup and any
other information on the computer. When you establish both passwords, only the setup password will
give you access to Computer Setup.

When both passwords are set, the setup password can also be used in place of the power-on
password as an override to log in to the computer. This is a useful feature for a network administrator.

If you forget the password for the computer, you can clear that password so you can gain access to the
information on the computer by resetting the password jumper.

CAUTION: Pushing the CMOS button will reset CMOS values to factory defaults. It is important to
back up the computer CMOS settings before resetting them in case they are needed later. Backup is
performed through Computer Setup. See Computer Setup (F10) Utility on page 10 for information on
backing up the CMOS settings.
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Resetting the Password Jumper
To reset the power-on or setup passwords, complete the following steps:

1. Shut down the operating system properly, then turn off the computer and any external devices,
and disconnect the power cord from the power outlet.

2. With the power cord disconnected, press the power button again to drain the system of any
residual power.

WARNING! To reduce the risk of personal injury from electrical shock and/or hot surfaces, be
sure to disconnect the power cord from the wall outlet, and allow the internal system components
to cool before touching.

CAUTION: When the computer is plugged in, the power supply always has voltage applied to
the system board even when the unit is turned off. Failure to disconnect the power cord can result
in damage to the system.

Static electricity can damage the electronic components of the computer or optional equipment.
Before beginning these procedures, ensure that you are discharged of static electricity by briefly
touching a grounded metal object. See the Safety & Regulatory Information guide for more
information.

3. Remove the access panel.

4. Locate the header and jumper labeled E49 on the system board.

NOTE: The password jumper is green so that it can be easily identified. For assistance locating
the password jumper and other system board components, see the Illustrated Parts & Service Map
(IPSM). The IPSM can be downloaded from http://www.hp.com/support.

5. Remove the jumper from the header.

6. Replace the jumper.

7. Replace the access panel.

8. Reconnect the external equipment.

9. Plug in the computer and turn on power. Allow the operating system to start. This clears the current
passwords and disables the password features.

10. Establish the new passwords in Computer Setup. Refer to Computer Setup (F10) Utility on page 10
for Computer Setup instructions.
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Clearing and Resetting the CMOS
The computer’s configuration memory (CMOS) stores information about the computer’s configuration.

The CMOS button resets CMOS but does not clear the power-on and setup passwords.

Clearing CMOS will clear the Active Management Technology (AMT) settings in the Management
Engine BIOS Extension (MEBx), including the password. The password will default to “admin” and will
need to be reset. The AMT settings will also need to be reset. To access the MEBx, press Ctrl+P during
POST.

1. Turn off the computer and any external devices, and disconnect the power cord from the power
outlet.

2. Disconnect any external equipment connected to the computer.

WARNING! To reduce the risk of personal injury from electrical shock and/or hot surfaces, be
sure to disconnect the power cord from the wall outlet, and allow the internal system components
to cool before touching.

CAUTION: When the computer is plugged in, the power supply always has voltage applied to
the system board even when the unit is turned off. Failure to disconnect the power cord can result
in damage to the system.

Static electricity can damage the electronic components of the computer or optional equipment.
Before beginning these procedures, ensure that you are discharged of static electricity by briefly
touching a grounded metal object. See the Safety & Regulatory Information guide for more
information.

3. Slide the rear cover off the computer.

CAUTION: Pushing the CMOS button will reset CMOS values to factory defaults. It is important
to back up the computer CMOS settings before resetting them in case they are needed later. Back
up is easily done through Computer Setup. See Computer Setup (F10) Utility on page 10 for
information on backing up the CMOS settings.

4. Open the memory door.
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5. Reach in, press, and hold the CMOS button in for five seconds. You can access the CMOS button
after removing the memory door.

NOTE: Make sure you have disconnected the AC power cord from the wall outlet. The CMOS
button will not clear CMOS if the power cord is connected.

Figure F-1  CMOS button

NOTE: For assistance locating the CMOS button and other system board components, see the
Illustrated Parts & Service Map (IPSM) for that particular system.

6. Close the memory door and replace the rear cover.

7. Reconnect the external devices.

8. Plug in the computer and turn on power.

NOTE: You will receive POST error messages after clearing CMOS and rebooting advising you
that configuration changes have occurred. Use Computer Setup to reset any special system setups
along with the date and time.

For instructions on Computer Setup, see Computer Setup (F10) Utility on page 10.
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G Troubleshooting Without
Diagnostics

This chapter provides information on how to identify and correct minor problems, such as diskette drive,
hard drive, optical drive, graphics, audio, memory, and software problems. If you encounter problems
with the computer, refer to the tables in this chapter for probable causes and recommended solutions.

NOTE: For information on specific error messages that may appear on the screen during Power-On
Self-Test (POST) at startup, refer to Appendix A, POST Error Messages on page 133.

Safety and Comfort
WARNING! Misuse of the computer or failure to establish a safe and comfortable work environment
may result in discomfort or serious injury. Refer to the Safety & Comfort Guide at http://www.hp.com/
ergo for more information on choosing a workspace and creating a safe and comfortable work
environment. For more information, refer to the Safety & Regulatory Information guide.

Before You Call for Technical Support
If you are having problems with the computer, try the appropriate solutions below to try to isolate the
exact problem before calling for technical support.

● Run the HP diagnostic tool.

● Run the hard drive self-test in Computer Setup. Refer to Computer Setup (F10) Utility on page 10
for more information.

● Check the Power LED on the front of the computer to see if it is flashing red. The flashing lights are
error codes that will help you diagnose the problem. Refer to Appendix A, POST Error Messages
on page 133 for more information.

● If the screen is blank, plug the monitor into a different video port on the computer if one is
available. Or, replace the monitor with a monitor that you know is functioning properly.

● If you are working on a network, plug another computer with a different cable into the network
connection. There may be a problem with the network plug or cable.

● If you recently added new hardware, remove the hardware and see if the computer functions
properly.
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● If you recently installed new software, uninstall the software and see if the computer functions
properly.

● Boot the computer to the Safe Mode to see if it will boot without all of the drivers loaded. When
booting the operating system, use “Last Known Configuration.”

● Refer to the comprehensive online technical support at http://www.hp.com/support.

● Refer to Helpful Hints on page 148 in this guide.

To assist you in resolving problems online, HP Instant Support Professional Edition provides you with
self-solve diagnostics. If you need to contact HP support, use HP Instant Support Professional Edition's
online chat feature. Access HP Instant Support Professional Edition at: http://www.hp.com/go/ispe.

Access the Business Support Center (BSC) at http://www.hp.com/go/bizsupport for the latest online
support information, software and drivers, proactive notification, and worldwide community of peers
and HP experts.

If it becomes necessary to call for technical assistance, be prepared to do the following to ensure that
your service call is handled properly:

● Be in front of your computer when you call.

● Write down the computer serial number, product ID number, and monitor serial number before
calling.

● Spend time troubleshooting the problem with the service technician.

● Remove any hardware that was recently added to your system.

● Remove any software that was recently installed.

● Restore the system from the Recovery Disc Set that you created or restore the system to its original
factory condition in HP Backup and Recovery Manager.

CAUTION: Restoring the system will erase all data on the hard drive. Be sure to back up all data
files before running the restore process.

NOTE: Restoring the computer requires an external USB optical drive.

NOTE: For sales information and warranty upgrades (Care Packs), call your local authorized service
provider or dealer.

Helpful Hints
If you encounter problems with the computer, monitor, or software, see the following list of general
suggestions before taking further action:

● Check that the computer is plugged into a working electrical outlet.

● Check that the computer is turned on and the green power light is on.
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● Check the Power LED on the front of the display to see if it is flashing red. The flashing lights are
error codes that will help you diagnose the problem. Refer to Appendix A, POST Error Messages
on page 133 for more information.

● Turn up the brightness and contrast controls of the display if dim.

● If a keyboard is connected, press and hold any key. If the system beeps, then the keyboard should
be operating correctly.

● Check all cable connections for loose connections or incorrect connections.

● Wake the computer by pressing any key on the keyboard, pressing the power button, or tapping
the screen. If the system remains in suspend mode, shut down the computer by pressing and
holding the power button for at least four seconds then press the power button again to restart the
computer. If the system will not shut down, unplug the power cord, wait a few seconds, then plug
it in again. The computer will restart if it is set to power on automatically as soon as power is
restored in Computer Setup. If it does not restart, press the power button to start the computer.

● Reconfigure the computer after installing a non-plug and play expansion board or other option.
See Solving hardware installation problems on page 166 for instructions.

● Be sure that all the needed device drivers have been installed. For example, if you are using a
printer, you need a driver for that model printer.

● Remove all bootable media (if an external USB optical or diskette drive is attached) from the
system before turning it on.

● If you have installed an operating system other than the factory-installed operating system, check
to be sure that it is supported on the system.

CAUTION: When the computer is plugged into an AC power source, there is always voltage
applied to the system board. You must disconnect the power cord from the power source before
opening the computer to prevent system board or component damage.
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Solving Retail System-specific Problems
The issues listed in this section are specific to features available in this Retail System.

Table G-1  Solving Retail System-specific problems

Powered serial ports don't have power.

Cause Solution

Ports are not correctly configured in Computer Setup. 1. Run the Computer Setup utility.

2. Under Onboard Devices, make sure the correct setting
is selected for each individual serial port (A, B, if
available, C, and D).

Available settings are:

◦ Standard

◦ 5v on pins 1 and 9

◦ 12v on pins 1 and 9

A powered serial device was connected while system power
was on.

The computer must be powered off when you plug in powered
serial devices.

Disconnect the device, power off the system, plug in the
device, and power on the system.
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Solving general problems
You may be able to easily resolve the general problems described in this section. If a problem persists
and you are unable to resolve it yourself or if you feel uncomfortable about performing the operation,
contact an authorized dealer or reseller.

WARNING! When the computer is plugged into an AC power source, voltage is always applied to
the system board. To reduce the risk of personal injury from electrical shock and/or hot surfaces, be
sure to disconnect the power cord from the wall outlet and allow the internal system components to cool
before touching.

Table G-2  Solving general problems

Computer appears locked up and will not turn off when the power button is pressed.

Cause Solution

Software control of the power switch is not functional. 1. Press and hold the power button for at least four seconds
until the computer turns off.

2. Disconnect the power cord from the electrical outlet.

Computer will not respond to USB keyboard or mouse.

Cause Solution

Computer is in standby mode. To resume from standby mode, press the power button or
press any key.

CAUTION: When attempting to resume from standby
mode, do not hold down the power button for more than four
seconds. Otherwise, the computer will shut down and you will
lose any unsaved data.

System has locked up. Restart computer.

Computer date and time display is incorrect.

Cause Solution

RTC (real-time clock) battery may need to be replaced.

NOTE: Connecting the computer to a live AC outlet
prolongs the life of the RTC battery.

First, reset the date and time under Control Panel
(Computer Setup can also be used to update the RTC date
and time). If the problem persists, replace the RTC battery. See
the Removal and Replacement section for instructions on
installing a new battery, or contact an authorized dealer or
reseller for RTC battery replacement.
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Cursor will not move using the arrow keys on the keypad.

Cause Solution

The Num Lock key may be on. Press the Num Lock key. The Num Lock light should not be on
if you want to use the arrow keys. The Num Lock key can be
disabled (or enabled) in Computer Setup.

There is no sound or sound volume is too low.

Cause Solution

System volume may be set low or muted. 1. Check the F10 BIOS settings to make sure the internal
system speaker is not muted (this setting does not affect
the external speakers).

2. Make sure the external speakers are properly connected
and powered on and that the speakers' volume control is
set correctly.

3. Use the system volume control available in the operating
system to make sure the speakers are not muted or to
increase the volume.

4. Make sure that speakers are not muted in the On-Screen
Display (OSD).

Poor performance is experienced.

Cause Solution

Processor is hot. 1. Make sure airflow to the computer is not blocked. Leave
a 10.2-cm (4-inch) clearance on all vented sides of the
computer and above the monitor to permit the required
airflow.

2. Make sure fans are connected and working properly
(some fans only operate when needed).

3. Make sure the processor heat sink is installed properly.

Hard drive is full. Transfer data from the hard drive to create more space on the
hard drive.

Low on memory. Add more memory.

Hard drive fragmented. Defragment hard drive.

Program previously accessed did not release reserved memory
back to the system.

Restart the computer.

Virus resident on the hard drive. Run virus protection program.
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Table G-2  Solving general problems (continued)

Poor performance is experienced.

Cause Solution

Too many applications running. 1. Close unnecessary applications to free up memory.

2. Add more memory. Some applications run in the
background and can be closed by right-clicking on their
corresponding icons in the task tray. To prevent these
applications from launching at startup, go to Start > All
Programs > Accessories > Run and type
msconfig. On the Startup tab of the System
Configuration Utility, clear applications that you do not
want to launch automatically.

Some software applications, especially games, are stressful on
the graphics subsystem

1. Lower the display resolution for the current application or
consult the documentation that came with the application
for suggestions on how to improve performance by
adjusting parameters in the application.

2. Add more memory.

Cause unknown. Restart the computer.

Computer powered off automatically and the Power LED flashes Red two times, once every second,
followed by a two second pause, and the computer beeps two times. (Beeps stop after fifth iteration but
LEDs continue flashing).

Cause Solution

Processor thermal protection activated:

A fan may be blocked or not turning.

OR

The heat sink is not properly attached to the processor.

1. Ensure that the computer air vents are not blocked and
the processor cooling fan is running.

2. Open hood, press power button, and see if the processor
fan spins. If the processor fan is not spinning, make sure
the fan's cable is plugged onto the system board header.

3. If fan is plugged in, but is not spinning, then replace the
heat sink/fan assembly.
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System does not power on and the LEDs on the front of the computer are not flashing.

Cause Solution

System unable to power on. Press and hold the power button for less than 4 seconds. If the
hard drive LED turns green, then:

1. Check that the voltage selector, located on the rear of
the power supply on some models, is set to the
appropriate voltage. Proper voltage setting depends on
your region.

2. Replace the system board.

OR

Press and hold the power button for less than 4 seconds. If the
hard drive LED does not turn on green then:

1. Check that the unit is plugged into a working AC outlet.

2. Open computer and check that the power button board
cable is properly connected to the system board.

3. Check that power supply cables are properly connected
to the system board.

4. Check to see if the 5V_aux light on the system board is
turned on. If it is turned on, then replace the power
button board.

5. If the 5V_aux light on the system board is off, then
replace the power supply.

6. Replace the system board.
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Solving power problems
Common causes and solutions for power problems are listed in the following table.

Table G-3  Solving power problems

Computer powered off automatically and the Power LED flashes red two times, once every second,
followed by a two second pause, and the computer beeps two times. (Beeps stop after fifth iteration but
LEDs continue flashing.)

Cause Solution

Processor thermal protection activated:

A fan may be blocked or not turning.

OR

The heat sink is not properly attached to the processor.

1. Ensure that the computer air vents are not blocked and
the processor cooling fan is running.

2. Ensure the blower is running.

Power LED flashes red four times, once every second, followed by a two second pause, and the
computer beeps four times. (Beeps stop after fifth iteration but LEDs continue flashing.)

Cause Solution

Power failure (power supply is overloaded). 1. Check if a device is causing the problem by removing
ALL attached devices (such as hard, diskette, or optical
drives, and expansion cards). Power on the system. If the
system enters the POST, then power off and replace one
device at a time and repeat this procedure until failure
occurs. Replace the device that is causing the failure.
Continue adding devices one at a time to ensure all
devices are functioning properly.

2. Replace the power supply.

3. Replace the system board.

Solving hard drive problems

Table G-4  Solving hard drive problems

Hard drive error occurs.

Cause Solution

Hard disk has bad sectors or has failed. 1. Right-click Start, click Explore, and right-click on a
drive. Select Properties then select the Tools tab.
Under Error-checking click Check Now.

2. Use a utility to locate and block usage of bad sectors. If
necessary, reformat the hard disk.
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Disk transaction problem.

Cause Solution

Either the directory structure is bad or there is a problem with
a file.

Right-click Start, click Explore, and right-click on a drive.
Select Properties then select the Tools tab. Under Error-
checking click Check Now.

Drive not found (identified).

Cause Solution

Cable could be loose. Check cable connections.

The system may not have automatically recognized a newly
installed device.

See reconfiguration directions in the Solving hardware
installation problems on page 166 section. If the system still
does not recognize the new device, check to see if the device
is listed within Computer Setup. If it is listed, the probable
cause is a driver problem. If it is not listed, the probable cause
is a hardware problem.

If this is a newly installed drive, run the Computer Setup utility
and try adding a POST delay under Advanced > Power-
On.

The device is attached to a SATA port that has been hidden in
Computer Setup.

Run the Computer Setup utility and ensure Device Available
is selected for the device's SATA port in Security > Device
Security.

Drive responds slowly immediately after power-up. Run Computer Setup and increase the POST Delay in
Advanced > Power-On Options.

Nonsystem disk/NTLDR missing message.

NOTE: Only if external USB diskette drive is installed.

Cause Solution

The system is trying to start from a diskette that is not
bootable.

Remove the diskette from the diskette drive.

The system is trying to start from the hard drive but the hard
drive may have been damaged.

1. Insert a bootable diskette into the diskette drive and
restart the computer.

2. Check the hard drive format using fdisk: If NTFS
formatting, use a third party reader to evaluate the drive.
If FAT32 formatting, the hard drive cannot be accessed.

System files missing or not properly installed. 1. Insert a bootable diskette into the diskette drive and
restart the computer.

2. Check the hard drive format using Fdisk: If NFTFS
formatting, use a third party reader to evaluate the drive.
If FAT32 formatting, the hard drive cannot be accessed.

3. Install system files for the appropriate operating system.
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Table G-4  Solving hard drive problems (continued)

Nonsystem disk/NTLDR missing message.

NOTE: Only if external USB diskette drive is installed.

Cause Solution

Hard drive boot has been disabled in Computer Setup. Run the Computer Setup utility and enable the hard drive entry
in the Storage > Boot Order list.

Bootable hard drive is not attached as first in a multi-hard
drive configuration.

If attempting to boot from a hard drive, ensure it is attached to
the system board dark blue SATA connector.

Bootable hard drive's controller is not listed first in the Boot
Order.

Run the Computer Setup utility and select Storage > Boot
Order and ensure the bootable hard drive's controller is
listed immediately under the Hard Drive entry.

Computer will not boot from hard drive.

Cause Solution

The device is attached to a SATA port that has been hidden in
Computer Setup.

Run the Computer Setup utility and ensure Device Available
is selected for the device's SATA port in Security > Device
Security.

Boot order is not correct. Run the Computer Setup utility and change boot sequence in
Storage > Boot Order.

Hard drive is damaged. Observe if the Power LED is blinking RED and if any beeps
are heard. See Appendix A, POST Error Messages
on page 133 to determine possible causes for the blinking red
and beep codes.

See the Worldwide Limited Warranty for terms and
conditions.

Computer seems to be locked up.

Cause Solution

Program in use has stopped responding to commands. Attempt the normal Windows “Shut Down” procedure. If this
fails, press the power button for four or more seconds to turn
off the power. To restart the computer, press the power button
again.

The removable hard drive enclosure is beeping and the green LED is flashing.

Cause Solution

Fan failure alarm on the removable hard drive enclosure has
been activated.

Shut down the computer and contact HP for a replacement
enclosure.
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Solving media card reader problems

Table G-5  Solving media card reader problems

A write-protected or locked error occurs when attempting to write to the media card.

Cause Solution

Media card is locked. Locking the media card is a safety
feature that prevents writing to and deleting from an SD/
Memory Stick/PRO card.

If using an SD card, make sure that the lock tab located on the
right of the SD card is not in the locked position. If using a
Memory Stick/PRO card, make sure that the lock tab located
on the bottom of the Memory Stick/PRO card is not in the
locked position.

Can not write to the media card.

Cause Solution

The media card is a read-only memory (ROM) card. Check the manufacturer’s documentation included with your
card to see if it writable. Refer to the previous section for a list
of compatible cards.

Media card is locked. Locking the media card is a safety
feature that prevents writing to and deleting from an SD/
Memory Stick/PRO card.

If using an SD card, make sure that the lock tab located on the
right of the SD card is not in the locked position. If using a
Memory Stick/PRO card, make sure that the lock tab located
on the bottom of the Memory Stick/PRO card is not in the
locked position.

Unable to access data on the media card after inserting it into a slot.

Cause Solution

The media card is not inserted properly, is inserted in the
wrong slot, or is not supported.

Ensure that the card is inserted properly with the gold contact
on the correct side. The green LED will light if inserted
properly.

Do not know how to remove a media card correctly.

Cause Solution

The computer’s software is used to safely eject the card. Open Computer, right-click on the corresponding drive icon,
and select Eject. Then pull the card out of the slot.

NOTE: Never remove the card when the green LED is
flashing
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Solving display problems
If you encounter display problems, see the documentation that came with the monitor and to the
common causes and solutions listed in the following table.

Table G-6  Solving display problems

Blank screen (no video).

Cause Solution

You may have a screen blanking utility installed or energy
saver features are enabled.

Use the touch keyboard, or If a keyboard or mouse is
installed, press any key or click the mouse button and, if set,
type your password.

System ROM is corrupted; system is running in Boot Block
Emergency Recovery Mode (indicated by eight beeps).

Reflash the system ROM with the latest BIOS image.

Computer is in standby mode. Press the power button or touch the screen to resume from
standby mode.

CAUTION: When attempting to resume from standby
mode, do not hold down the power button for more than four
seconds. Otherwise, the computer will shut down and you will
lose any unsaved data.

Blank screen and the power LED flashes red five times, once every second, followed by a two second
pause, and the computer beeps five times. (Beeps stop after fifth iteration but LEDs continue flashing.)

Cause Solution

Pre-video memory error. 1. Reseat DIMMs. Power on the system.

2. Replace DIMMs one at a time to isolate the faulty
module.

3. Replace third-party memory with HP memory.

4. Replace the system board.

Blank screen and the power LED flashes red six times, once every second, followed by a two second
pause, and the computer beeps six times. (Beeps stop after fifth iteration but LEDs continue flashing.)

Cause Solution

Pre-video graphics error. For systems with a graphics card:

1. Replace the system board.

For systems with integrated graphics, replace the system
board.

Solving display problems 159



Blank screen and the power LED flashes red seven times, once every second, followed by a two second
pause, and the computer beeps seven times. (Beeps stop after fifth iteration but LEDs continue flashing.)

Cause Solution

System board failure (ROM detected failure prior to video). Replace the system board.

Blurry video or requested resolution cannot be set.

Cause Solution

The correct graphics drivers may not be loaded. Update graphics drivers.

Graphics card is bad. Replace the graphics card.

Image is not centered.

Cause Solution

Position may need adjustment. Press the display's Menu button to access the OSD menu.
Select ImageControl/ Horizontal Position or Vertical
Position to adjust the horizontal or vertical position of the
image.

“Out of Range” displays on screen.

Cause Solution

Video resolution and refresh rate are set higher than what the
monitor supports.

Restart the computer and enter Safe Mode. Change the
settings to a supported setting then restart the computer so that
the new settings take effect.

Fuzzy focus; streaking, ghosting, or shadowing effects; horizontal scrolling lines; faint vertical bars; or
unable to center the picture on the screen (flat panel monitors using an analog VGA input connection
only).

Cause Solution

The correct graphics drivers may not be loaded. 1. Update the graphics driver.

Certain typed symbols do not appear correct.

Cause Solution

The font you are using does not support that particular
symbol.

Use the Character Map to locate and select the appropriate
symbol. Click Start > All Programs > Accessories >
System Tools > Character Map. You can copy the
symbol from the Character Map into a document.
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Solving audio problems
If the computer has audio features and you encounter audio problems, see the common causes and
solutions listed in the following table.

Table G-7  Solving audio problems

Sound cuts in and out.

Cause Solution

Processor resources are being used by other open
applications.

Shut down all open processor-intensive applications.

Sound does not come out of the speaker or headphones.

Cause Solution

Software volume control is turned down or muted. Double-click the Speaker icon on the taskbar, then make
sure that Mute is not selected and use the volume slider to
adjust the volume.

Audio is hidden in Computer Setup. Enable the audio in Computer Setup: Security >
Device Security > System Audio.

Speakers muted in On-Screen Display (OSD) settings. Make sure the speakers are not muted in the OSD.

The external speakers are not turned on. Turn on the external speakers.

The audio device may be connected to the wrong jack. Ensure that the device is connected to the correct jack on the
computer. The speakers should be plugged into the rear line-
out jack and the headphones should be plugged into the front
headphone jack.

External speakers plugged into the wrong audio jack on a
recently installed sound card.

See the sound card documentation for proper speaker
connection.

Headphones or devices connected to the line-out connector
mute the internal speaker.

Turn on and use headphones or external speakers, if
connected, or disconnect headphones or external speakers.

Computer is in standby mode. Press the power button or touch the screen to resume from
standby mode.

CAUTION: When attempting to resume from standby
mode, do not hold down the power button for more than four
seconds. Otherwise, the computer will shut down and you will
lose any unsaved data.

Internal speaker is disabled in Computer Setup. Enable the internal speaker in Computer Setup. Select
Advanced > Device Options > Internal Speaker.

The application is set to use a different audio device than
speakers.

Make sure the correct device is being used.

Some applications can select which audio output device is
used.

Make sure the application has selected the correct audio
device.
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Table G-7  Solving audio problems (continued)

Sound does not come out of the speaker or headphones.

Cause Solution

The operating system controls may be set to use a different
audio device as the default output device than what is
expected.

Set the operating system to use the correct audio device.

Speakers muted in On-Screen Display (OSD) settings. Make sure the speakers are not muted in the OSD.

Sound from headphones is not clear or muffled.

Cause Solution

Headphones are plugged into the rear audio output
connector. The rear audio output connector is for powered
audio devices and is not designed for headphone use.

Plug the headphones into the headphone connector on the
front of the computer.

Computer appears to be locked up while recording audio.

Cause Solution

The hard disk may be full. Before recording, make sure there is enough free space on the
hard disk. You can also try recording the audio file in a
compressed format.

Line-in jack is not functioning properly.

Cause Solution

Jack has been reconfigured in the audio driver or application
software.

In the audio driver or application software, reconfigure the
jack or set the jack to its default value.

There is no sound or sound volume is too low.

Cause Solution

The application is set to use a different audio device than
speakers.

Make sure the correct device is being used.

Some applications can select which audio output device is
used.

Make sure the application has selected the correct audio
device.

The operating system controls may be set to use a different
audio device as the default output device than what is
expected.

Set the operating system to use the correct audio device.

Speakers muted in On-Screen Display (OSD) settings. Make sure the speakers are not muted in the OSD.
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Solving printer problems
If you encounter printer problems, see the documentation that came with the printer and to the common
causes and solutions listed in the following table.

Table G-8  Solving printer problems

Printer will not print.

Cause Solution

Printer is not turned on and online. Turn the printer on and make sure it is online.

The correct printer drivers for the application are not installed. 1. Install the correct printer driver for the application.

2. Try printing using the MS-DOS command:

DIR C:\ > [printer port]

where [printer port] is the address of the printer being
used. If the printer works, reload the printer driver.

If you are on a network, you may not have made the
connection to the printer.

Make the proper network connections to the printer.

Printer may have failed. Run printer self-test.

Printer will not turn on.

Cause Solution

The cables may not be connected properly. Reconnect all cables and check the power cord and electrical
outlet.

Printer prints garbled information.

Cause Solution

The correct printer driver for the application is not installed. Install the correct printer driver for the application.

The cables may not be connected properly. Reconnect all cables.

Printer memory may be overloaded. Reset the printer by turning it off for one minute, then turn it
back on.

Printer is offline.

Cause Solution

The printer may be out of paper. Check the paper tray and refill it if it is empty. Select online.
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Solving keyboard and mouse problems (if installed)
If you encounter keyboard or mouse problems, see the documentation that came with the equipment
and to the common causes and solutions listed in the following table.

Table G-9  Solving keyboard problems

Keyboard commands and typing are not recognized by the computer.

Cause Solution

Keyboard connector is not properly connected. 1. Click Start, click the arrow on the lower right corner of
the Start menu, then select Shut Down.

2. After the shutdown is complete, reconnect the keyboard
to the back of the computer and restart the computer.

Program in use has stopped responding to commands. Shut down your computer using the mouse and then restart the
computer.

Keyboard needs repairs. See the Worldwide Limited Warranty for terms and
conditions.

Computer is in standby mode. Press the power button to resume from standby mode.

CAUTION: When attempting to resume from standby
mode, do not hold down the power button for more than four
seconds. Otherwise, the computer will shut down and you will
lose any unsaved data.

Cursor will not move using the arrow keys on the keypad.

Cause Solution

The Num Lock key may be on. Press the Num Lock key. The Num Lock light should not be on
if you want to use the arrow keys. The Num Lock key can be
disabled (or enabled) in Computer Setup.

Table G-10  Solving Mouse Problems

Mouse does not respond to movement or is too slow.

Cause Solution

Mouse connector is not properly plugged into the back of the
computer.

Shut down the computer using the keyboard.

1. Press the Ctrl and Esc keys at the same time (or press the
Windows logo key) to display the Start menu.

2. Use the arrow keys to select Shut Down and then press
the Enter key.

3. After the shutdown is complete, plug the mouse
connector into the back of the computer (or the
keyboard) and restart.
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Table G-10  Solving Mouse Problems (continued)

Mouse does not respond to movement or is too slow.

Cause Solution

Program in use has stopped responding to commands. Shut down the computer using the keyboard then restart the
computer.

Mouse may need cleaning. Remove the roller ball cover on the mouse and clean the
internal components.

Mouse may need repair. See the Worldwide Limited Warranty for terms and
conditions.

Computer is in standby mode. Press the power button to resume from standby mode.

CAUTION: When attempting to resume from standby
mode, do not hold down the power button for more than four
seconds. Otherwise, the computer will shut down and you will
lose any unsaved data.

Mouse will only move vertically, horizontally, or movement is jerky.

Cause Solution

Mouse roller ball or the rotating encoder shafts that make
contact with the ball are dirty.

Remove roller ball cover from the bottom of the mouse and
clean the internal components with a mouse cleaning kit
available from most computer stores.
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Solving hardware installation problems
You may need to reconfigure the computer when you add or remove hardware, such as an additional
drive or expansion card. If you install a plug and play device, Windows automatically recognizes the
device and configures the computer. If you install a non–plug and play device, you must reconfigure the
computer after completing installation of the new hardware. In Windows, use the Add Hardware
Wizard and follow the instructions that appear on the screen.

WARNING! When the computer is plugged into an AC power source, voltage is always applied to
the system board. To reduce the risk of personal injury from electrical shock and/or hot surfaces, be
sure to disconnect the power cord from the wall outlet and allow the internal system components to cool
before touching.

Table G-11  Solving hardware installation problems

A new device is not recognized as part of the system.

Cause Solution

Device is not seated or connected properly. Ensure that the device is properly and securely connected and
that pins in the connector are not bent down.

Cable(s) of new external device are loose or power cables
are unplugged.

Ensure that all cables are properly and securely connected
and that pins in the cable or connector are not bent down.

Power switch of new external device is not turned on. Turn off the computer, turn on the external device, then turn on
the computer to integrate the device with the computer system.

When the system advised you of changes to the configuration,
you did not accept them.

Reboot the computer and follow the instructions for accepting
the changes.

A plug and play board may not automatically configure when
added if the default configuration conflicts with other devices.

Use Windows Device Manager to deselect the automatic
settings for the board and choose a basic configuration that
does not cause a resource conflict. You can also use
Computer Setup to reconfigure or disable devices to resolve
the resource conflict.

USB ports on the computer are disabled in Computer Setup. Run the Computer Setup utility and ensure that Device
available is selected for appropriate USB ports under
Security > USB Security.
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Computer will not start.

Cause Solution

Wrong memory modules were used in the upgrade or
memory modules were installed in the wrong location.

1. Review the documentation that came with the system to
determine if you are using the correct memory modules
and to verify the proper installation.

NOTE: DIMM1 must always be installed. DIMM1 must
be installed before DIMM3.

2. Observe the beeps and LED lights on the front of the
computer. Beeps and flashing LEDs are codes for specific
problems.

3. If you still cannot resolve the issue, contact Customer
Support.

Power LED flashes red five times, once every second, followed by a two second pause, and the computer
beeps five times. (Beeps stop after fifth iteration but LEDs continue flashing.)

Cause Solution

Memory is installed incorrectly or is bad. CAUTION: To avoid damage to the DIMMs or the system
board, you must unplug the computer power cord before
attempting to reseat, install, or remove a DIMM module.

1. Reseat DIMMs. Power on the system.

2. Replace DIMMs one at a time to isolate the faulty
module.

NOTE: DIMM1 must always be installed. DIMM1 must
be installed before DIMM3.

3. Replace third-party memory with HP memory.

4. Replace the system board.
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Solving network problems
Some common causes and solutions for network problems are listed in the following table. These
guidelines do not discuss the process of debugging the network cabling.

Table G-12  Solving network problems

Wake-on-LAN feature is not functioning.

Cause Solution

S5 Maximum Power Saving feature is enabled. Disable the S5 Maximum Power Saving option in Computer
Setup. Select Power > Hardware Power Management
> S5 Maximum Power Saving.

S5 Wake on LAN is disabled. : Enable the S5 Wake on LAN option in Computer Setup.
Select Advanced > Device Options > S5 Wake on
LAN.

Wake-on-LAN is not enabled. 1. Select Start > Control Panel.

2. Under Network and Internet, select View
network status and tasks.

3. Click Local Area Connection.

4. Click the Properties button.

5. Click the Configure button.

6. Click the Power Management tab, then select the
check box to Allow this device to wake the
computer.

Network driver does not detect network controller.

Cause Solution

Network controller is disabled. 1. Run Computer Setup and enable network controller.

2. Enable the network controller in the operating system via
Device Manager.

Incorrect network driver. Check the network controller documentation for the correct
driver or obtain the latest driver from the manufacturer’s Web
site.

Network status link light never flashes.

NOTE: The network status light is supposed to flash when there is network activity.

Cause Solution

No active network is detected. Check cabling and network equipment for proper connection.
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Table G-12  Solving network problems (continued)

Network status link light never flashes.

NOTE: The network status light is supposed to flash when there is network activity.

Cause Solution

Network controller is not set up properly. Check for the device status within Windows, such as Device
Manager for driver load and the Network Connections applet
within Windows for link status.

Network controller is disabled. 1. Run Computer Setup and enable network controller.

2. Enable the network controller in the operating system via
Device Manager.

Network driver is not properly loaded. Reinstall network drivers.

System cannot autosense the network. Disable auto-sensing capabilities and force the system into the
correct operating mode.

Diagnostics reports a failure.

Cause Solution

The cable is not securely connected. Ensure that the cable is securely attached to the network
connector and that the other end of the cable is securely
attached to the correct device.

The cable is attached to the incorrect connector. Ensure that the cable is attached to the correct connector.

There is a problem with the cable or a device at the other end
of the cable.

Ensure that the cable and device at the other end are
operating correctly.

Network controller interrupt is shared with an expansion
board.

Under the Computer Setup Advanced menu, change the
resource settings for the board.

The network controller is defective. Contact an authorized service provider.

Diagnostics passes, but the computer does not communicate with the network.

Cause Solution

Network drivers are not loaded, or driver parameters do not
match current configuration.

Make sure the network drivers are loaded and that the driver
parameters match the configuration of the network controller.

Make sure the correct network client and protocol is installed.

The network controller is not configured for this computer. Select the Network icon in the Control Panel and
configure the network controller.
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Network controller stopped working when an expansion board was added to the computer.

Cause Solution

Network controller interrupt is shared with an expansion
board.

Under the Computer Setup Advanced menu, change the
resource settings for the board.

The network controller requires drivers. Verify that the drivers were not accidentally deleted when the
drivers for a new expansion board were installed.

The expansion board installed is a network card (NIC) and
conflicts with the embedded NIC.

Under the Computer Setup Advanced menu, change the
resource settings for the board.

Network controller stops working without apparent cause.

Cause Solution

The files containing the network drivers are corrupted. Reinstall the network drivers, using the Recovery Disc Set
created from the hard drive's Recovery Partition.

The cable is not securely connected. Ensure that the cable is securely attached to the network
connector and that the other end of the cable is securely
attached to the correct device.

The network controller is defective. Contact an authorized service provider.

New network card will not boot.

Cause Solution

New network card may be defective or may not meet industry-
standard specifications.

Install a working, industry-standard NIC, or change the boot
sequence to boot from another source.

Cannot connect to network server when attempting Remote System Installation.

Cause Solution

The network controller is not configured properly. Verify Network Connectivity, that a DHCP Server is present,
and that the Remote System Installation Server contains the
NIC drivers for your NIC.

System setup utility reports unprogrammed EEPROM.

Cause Solution

Unprogrammed EEPROM. Contact an authorized service provider.
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Solving memory problems
If you encounter memory problems, some common causes and solutions are listed in the following
table.

CAUTION: Power may still be supplied to the DIMMs when the computer is turned off (depending on
the Management Engine (ME) settings). To avoid damage to the DIMMs or the system board, you must
unplug the computer power cord before attempting to reseat, install, or remove a DIMM module.

For those systems that support ECC memory, HP does not support mixing ECC and non-ECC memory.
Otherwise, the computer will not boot the operating system.

Table G-13  Solving memory problems

System will not boot or does not function properly after installing additional memory modules.

Cause Solution

A memory module is not installed in the DIMM1 socket. Ensure that a memory module is installed in the DIMM1 socket
on the system board. This socket must be populated with a
memory module.

Memory module is not the correct type or speed grade for the
system or the new memory module is not seated properly.

Replace module with the correct industry-standard device for
the computer. ECC and non-ECC memory modules cannot be
mixed.

Out of memory error.

Cause Solution

Memory configuration may not be set up correctly. Use the Device Manager to check memory configuration.

You have run out of memory to run the application. Check the application documentation to determine the
memory requirements.

Memory count during POST is wrong.

Cause Solution

The memory modules may not be installed correctly. Check that the memory modules have been installed correctly
and that proper modules are used.

Integrated graphics may use system memory. No action required.
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Insufficient memory error during operation.

Cause Solution

Too many Terminate and Stay Resident programs (TSRs) are
installed.

Delete any TSRs that you do not need.

You have run out of memory for the application. Check the memory requirements for the application or add
more memory to the computer.

Power LED flashes red five times, once every second, followed by a two second pause, and the computer
beeps five times. (Beeps stop after fifth iteration but LEDs continue flashing.)

Cause Solution

Memory is installed incorrectly or is bad. 1. Reseat DIMMs. Power on the system.

2. Replace DIMMs one at a time to isolate the faulty
module.

3. Replace third-party memory with HP memory.

4. Replace the system board.

Solving processor problems
If you encounter processor problems, common causes and solutions are listed in the following table.

Table G-14  Solving processor problems

Poor performance is experienced.

Cause Solution

Processor is hot. 1. Make sure the airflow to the computer is not blocked.

2. Make sure the fans are connected and working properly
(some fans only operate when needed).

3. Make sure the processor heat sink is installed properly.

Power LED flashes red three times, once every second, followed by a two second pause.

Cause Solution

Processor is not seated properly or not installed. 1. Check to see that the processor is present.

2. Reseat the processor.
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Power LED flashes red eleven times, once every second, followed by a two second pause.

Cause Solution

The current processor does not support a feature previously
enabled on this system.

1. Install a TXT capable processor.

2. Disable TXT in the Computer Setup (F10) utility.

3. Reinstall the original processor.

Solving USB flash drive problems
If you encounter USB flash drive problems, common causes and solutions are listed in the following
table.

Table G-15  Solving USB flash drive problems

USB flash drive is not seen as a drive letter in Windows.

Cause Solution

The drive letter after the last physical drive is not available. Change the default drive letter for the flash drive in Windows.

USB flash drive not found (identified).

Cause Solution

The device is attached to a USB port that has been hidden in
Computer Setup.

Run the Computer Setup utility and ensure that “Device
available” is selected for “Front USB Ports” and “Rear USB
Ports” under Security > Device Security.

The device was not properly seated before power-up. Ensure the device is fully inserted into the USB port before
applying power to the system

System will not boot from USB flash drive.

Cause Solution

Boot order is not correct. Run the Computer Setup utility and change boot sequence in
Storage > Boot Order.

Removable Media Boot is disabled in the Computer Setup
utility.

Run the Computer Setup utility and enable booting to
removable media in Storage > Storage Options. Ensure
USB is enabled in Storage > Boot Order.

The computer boots to DOS after making a bootable flash drive.

Cause Solution

Flash drive is bootable. Install the flash drive only after the operating system boots.
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Solving internet access problems
If you encounter Internet access problems, consult your Internet Service Provider (ISP) or refer to the
common causes and solutions listed in the following table.

Table G-16  Solving internet access problems

Unable to connect to the Internet.

Cause Solution

Internet Service Provider (ISP) account is not set up properly. Verify Internet settings or contact your ISP for assistance.

Modem is not set up properly. Reconnect the modem. Verify the connections are correct
using the quick setup documentation.

Web browser is not set up properly. Verify that the Web browser is installed and set up to work
with your ISP.

Cable/DSL modem is not plugged in. Plug in cable/DSL modem. You should see a “power” LED
light on the front of the cable/DSL modem.

Cable/DSL service is not available or has been interrupted
due to bad weather.

Try connecting to the Internet at a later time or contact your
ISP. (If the cable/DSL service is connected, the “cable” LED
light on the front of the cable/DSL modem will be on.)

The CAT5 UTP cable is disconnected. Connect the CAT5 UTP cable between the cable modem and
the computers’s RJ-45 connector. (If the connection is good,
the “PC” LED light on the front of the cable/DSL modem will
be on.)

IP address is not configured properly. Contact your ISP for the correct IP address.

Cookies are corrupted. (A “cookie” is a small piece of
information that a Web server can store temporarily with the
Web browser. This is useful for having the browser remember
some specific information that the Web server can later
retrieve.)

1. Select Start > Control Panel.

2. Click Network and Internet.

3. Click Internet Options.

4. In the Browsing history section on the General tab,
click the Delete button.

5. Select the Cookies check box and click the Delete
button.

Cannot automatically launch Internet programs.

Cause Solution

You must log on to your ISP before some programs will start. Log on to your ISP and launch the desired program.
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Internet takes too long to download Web sites.

Cause Solution

Modem is not set up properly. Verify that the modem is connected and communicating
properly.

1. Select Start > Control Panel.

2. Click on Hardware and Sound.

3. Click on Device Manager.

4. Double-click Modems.

5. Select the modem.

6. On the General tab, click Diagnostics.

7. Click Query Modem. A “Success” response indicates
the modem is connected and working properly.
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Solving software problems
Most software problems occur as a result of the following:

● The application was not installed or configured correctly.

● There is insufficient memory available to run the application.

● There is a conflict between applications.

● Be sure that all the needed device drivers have been installed.

● If you have installed an operating system other than the factory-installed operating system, check
to be sure it is supported on the system.

If you encounter software problems, see the applicable solutions listed in the following table.

Table G-17  Solving software problems

Computer will not continue and no HP logo screen has appeared.

Cause Solution

POST error has occurred. Observe the beeps and LED lights on the front of the
computer. See Appendix A, POST Error Messages
on page 133 to determine possible causes.

See the Restore Kit or the Worldwide Limited Warranty for
terms and conditions.

Computer will not continue after HP logo screen has appeared.

Cause Solution

System files may be damaged. Use recovery diskette to scan hard drive for errors.

“Illegal Operation has Occurred” error message is displayed.

Cause Solution

Software being used is not Microsoft-certified for your version
of Windows.

Verify that the software is certified by Microsoft for your
version of Windows (see program packaging for this
information).

Configuration files are corrupt. If possible, save all data, close all programs, and restart the
computer.
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